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THANK YOU FOR CHOOSING ROSS VIDEO
You've made a great choice. We expect you will be very happy with your purchase of Ross Technology. 
Our mission is to:

1. Provide a Superior Customer Experience
• offer the best product quality and support

2. Make Cool Practical Technology

• develop great products that customers love
Ross has become well known for the Ross Video Code of Ethics. It guides our interactions and 
empowers our employees. I hope you enjoy reading it below.
If anything at all with your Ross experience does not live up to your expectations be sure to reach out to 
us at solutions@rossvideo.com.

David Ross
CEO, Ross Video
david.ross@rossvideo.com

Ross Video Code of Ethics
Any company is the sum total of the people that make things happen. At Ross, our employees are a 
special group. Our employees truly care about doing a great job and delivering a high quality customer 
experience every day. This code of ethics hangs on the wall of all Ross Video locations to guide our 
behavior:

1. We will always act in our customers’ best interest.
2. We will do our best to understand our customers’ requirements.
3. We will not ship crap.

4. We will be great to work with.
5. We will do something extra for our customers, as an apology, when something big goes wrong and 

it's our fault.
6. We will keep our promises.

7. We will treat the competition with respect.
8. We will cooperate with and help other friendly companies.
9. We will go above and beyond in times of crisis. If there's no one to authorize the required action in 

times of company or customer crisis - do what you know in your heart is right. (You may rent 
helicopters if necessary.)
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Important Regulatory and Safety Notices to Service Personnel
Before using this product and any associated equipment, refer to the “ Important Safety Instructions ” listed in 
the front of this manual to avoid personnel injury and to prevent product damage.

Product may require specific equipment, and/or installation procedures to be carried out to satisfy certain regulatory 
compliance requirements. Notices have been included in this publication to call attention to these specific 
requirements.

Symbol Definitions

 Protective Earth: This symbol identifies a Protective Earth (PE) terminal, which is provided for connection 

of the supply system's protective earth (green or green/yellow) conductor.

 Important: This symbol on the equipment refers you to important operating and maintenance (servicing) 

instructions within the Product Manual Documentation. Failure to heed this information may present a major risk of 
damage or injury to persons or equipment.

 Warning: The symbol with the word “ Warning ” within the equipment manual indicates a potentially 

hazardous situation which, if not avoided, could result in death or serious injury.

 CAUTION: The symbol with the word “ Caution ” within the equipment manual indicates a potentially 

hazardous situation which, if not avoided, may result in minor or moderate injury. It may also be used to alert 
against unsafe practices.



 Warning Hazardous Voltages: This symbol is intended to alert the user to the presence of uninsulated “ 

dangerous voltage ” within the product enclosure that may be of sufficient magnitude to constitute a risk of shock to 
persons.

 ESD Susceptibility: This symbol is used to alert the user that an electrical or electronic device or assembly is 

susceptible to damage from an ESD event.

Important Safety Instructions
General Safety Instructions

1.  Warning: Read these instructions.

2. Keep these instructions.

3. Heed all warnings.

4. Follow all instructions.

5. Do not use this apparatus near water.

6. Clean only with a dry cloth.

7. Do not block any ventilation openings. Install in accordance with manufacturer's instructions.

8. Do not install near heat sources such as radiators, heat registers, stoves, or other apparatus (including 
amplifiers) that produce heat.

9. Do not defeat the safety purpose of the polarized or grounding-type plug. A polarized plug has two blades with 
one wider than the other. A grounding type plug has two blades and a third grounding prong. The third prong is 
provided for your safety. If the provided plug does not fit into your outlet, consult an electrician for 
replacement of the obsolete outlet.

10. Protect the power cord from being walked on or pinched, particularly at plugs, convenience receptacles, and 
the point where they exit from the apparatus.

11. Only use attachments/accessories specified by the manufacturer.

12. Unplug this apparatus during lightning storms or when unused for long periods of time.

13. Refer all servicing to qualified service personnel. Servicing is required when the apparatus has been damaged 
in any way, such as when the power-supply cord or plug is damaged, liquid has been spilled or objects have 
fallen into the apparatus, the apparatus has been exposed to rain or moisture, does not operate normally, or has 
been dropped.

14. Do not expose this apparatus to dripping or splashing, and ensure that no objects filled with liquids, such as 
vases, are placed on the apparatus.

15. To completely disconnect this apparatus from the AC Mains, disconnect the power supply cord plug from the 
AC receptacle.

16. The mains plug of the power supply cord shall remain readily operable.

17.  Warning: Indoor Use: To reduce the risk of fire or electric shock, do not expose this apparatus to rain or 

moisture.

18. The safe operation of this product requires that a protective earth connection be provided. A grounding 
conductor in the equipment's supply cord provides this protective earth. To reduce the risk of electrical shock to 
the operator and service personnel, this ground conductor must be connected to an earthed ground.



19.  Warning: This apparatus, when equipped with multiple power supplies, can generate high leakage 

currents. To reduce the risk of electric shock, ensure that each individual supply cord is connected to its own 
separate branch circuit with an earth connection.

20.  CAUTION: These service instructions are for use by qualified service personnel only. To reduce the risk 

of electric shock, do not perform any servicing other than that contained in the operating instructions unless 
you are qualified to do so.

21. Service barriers within this product are intended to protect the operator and service personnel from hazardous 
voltages. For continued safety, replace all barriers after servicing.

22. This product contains safety critical parts, which, if incorrectly replaced, may present a risk of fire or electrical 
shock. Components contained within the product's power supplies and power supply area are not intended to be 
customer-serviced and should be returned to the factory for repair.

23. Use only power cords specified for this product and certified for the country of use.

24. The safe operation of this equipment requires that the user heed and adhere to all installation and servicing 
instruction contained within the equipment's Setup Manuals.

25.  CAUTION: This product includes “ Ethernet Ports ” which allow this product to be connected to local 

area networks (LAN). Only connect to networks that remain inside the building. Do not connect to networks 
that go outside the building.

26. For use at altitude 2000m or lower.

27. For use in non-tropical locations.

28.  CAUTION: Do not make mechanical or electrical modifications to the equipment or add metallic items, 

such as metallic foil labels, to the printed circuit boards. Modifications can impair regulatory compliance, or 
performance and may void your warranty.

29.  CAUTION: RISK OF ABNORMAL SUPPLY LOADING: USB connected accessory loading not to 

exceed 5 USB unit loads. Each USB unit Load on Rear panel is limited to 250mA max.

30.  CAUTION: This apparatus contains a Lithium battery, which if replaced incorrectly, or with an 

incorrect type, may cause an explosion. Replace only with a CR2032 coin type lithium battery. Dispose of used 
batteries according to the manufacturer’s instruction by qualified service personnel.

EMC Notices
United States of America — FCC Part 15

This equipment has been tested and found to comply with the limits for a class A Digital device, pursuant to part 15 
of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the 
equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio 
frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful 
interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful 
interference in which case the user will be required to correct the interference at his own expense.

 Important: Changes or modifications to this equipment not expressly approved by Ross Video Limited 

could void the user's authority to operate this equipment.

Canada

This Class “ A ” digital apparatus complies with Canadian ICES-003.



Cet appareil numerique de la classe “ A ” est conforme a la norme NMB-003 du Canada.

Korea - Class A Statement

이기기는업무용환경에서사용할목적으로적합성평가를받은기기로서가정용환경에서사용하는경우
전파간섭의우려가있습니다 .
This device has been evaluated for conformity for use in a business environment. When used in a home 
environment, there is a danger of interference.

Europe

This equipment is in compliance with the essential requirements and other relevant provisions of CE Directive 
93/68/EEC.

International

This equipment has been tested to CISPR 32:2015 along with amendment AMD1:2019, and found to comply with 
the limits for a Class A Digital device.

 Important: This is a Class A product. In domestic environments, this product may cause radio interference, 

in which case the user may have to take adequate measures.

General Handling Guidelines
• Careful handling, using proper ESD precautions, must be observed.
• Power down the system before PCB removal.

A Word About Static Discharge

Throughout the many procedures in this manual, please observe all static discharge precautions.

 CAUTION: Avoid handling the switcher circuit boards in high static environments such as carpeted areas, 

and when synthetic fiber clothing is worn. Touch the frame to dissipate static charge before removing boards from 
the frame, and exercise proper grounding precautions when working on circuit boards.

Environmental Information

Waste Electrical and Electronic Equipment Directive (WEEE Directive)

The equipment that you purchased required the extraction and use of natural resources for its production. It may 
contain hazardous substances that could impact health and the environment.

To avoid the potential release of those substances into the environment and to diminish the need for the extraction 
of natural resources, Ross Video encourages you to use the appropriate take-back systems. These systems will reuse 
or recycle most of the materials from your end-of-life equipment in an environmentally friendly and health 
conscious manner.

The crossed-out wheeled bin symbol invites you to use these systems.



If you need more information on the collection, reuse, and recycling systems, please contact your local or regional 
waste administration.

You can also contact Ross Video for more information on the environmental performances of our products.

Use of Hazardous Substances in Electrical and Electronic Products (China RoHS)

Ross Video Limited has reviewed all components and processes for compliance to:

“ Management Methods for the Restriction of the Use of Hazardous Substances in Electrical and Electronic 
Products ” also known as China RoHS.

The “ Environmentally Friendly Use Period ” (EFUP) and Hazardous Substance Tables have been established for 
all products. We are currently updating all of our Product Manuals. The Hazardous substances tables are available 
on our website at: http://www.rossvideo.com/about-ross/company-profile/green-practices/china-rohs.html

电器电子产品中有害物质的使用

Ross Video Limited 按照以下的标准对所有组件和 流程进行了审查：

" 电器电子产品有害物质限制使用管理办法 " 也被称 为中国 RoHS。

所有产品都具有 " 环保使用期限 " (EFUP) 和有害物 质表。目前，我们正在 更新我们所有的产品手册。

有害物质表在我们的网站 :
http://www.rossvideo.com/about-ross/company-profile/green-practices/china-rohs.html

Power Information
To ensure safe operation and to guard against potential shock or risk of fire, ensure your AC power source for the 
system is within the required voltage range and frequency.

• Rio Replay Server Chassis Input AC Power Requirements:
› 100-127VAC / 15.0-12.0A / 50-60Hz (x2)
› 200-240VAC / 8.5-7.0A / 50-60Hz (x2)

• Rio Replay Control Panel Input AC Power Requirements:
› 100-240VAC / 0.85A Max / 50-60Hz

Operating Environment
The optimum operating environment is within the following ranges:

• Rio Replay Server Chassis:
› Recommended Operating Temperature: 13°C to 35°C (55°F to 95°F)
› Recommended Operating Humidity: 20% to 80% non-condensing

• Rio Replay Control Panel:
› Recommended Operating Temperature: 0°C to 40°C (32°F to 104°F)
› Recommended Operating Humidity: 20% to 50% non-condensing

¬ High temperature/humidity should be avoided at all times.

https://www.rossvideo.com/company/overview/china-rohs/
https://www.rossvideo.com/company/overview/china-rohs/


Company Address

Technical Support
At Ross Video, we take pride in the quality of our products, but if a problem does occur, help is as close as the 
nearest telephone.

Our 24-Hour Hot Line service ensures you have access to technical expertise around the clock. After-sales service and 
technical support are provided directly by Ross Video personnel. During business hours (eastern standard time), 
technical support personnel are available by telephone. Outside of normal business hours and on weekends, a direct 
emergency technical support phone line is available. If the technical support personnel who is on call does not 
answer this line immediately, a voice message can be left and the call will be returned shortly. Our Technical 
support staff are available to react to any problem and to do whatever is necessary to ensure customer satisfaction.

Ross Video Limited 
8 John Street
Iroquois, Ontario
Canada, K0E 1K0

Ross Video Incorporated 
P.O. Box 880
Ogdensburg, New York
USA 13669-0880

General Business Office: (+1) 613 • 652 • 4886
Fax: (+1) 613 • 652 • 4425

E-mail (Technical Support): techsupport@rossvideo.com 
E-mail (General Information): solutions@rossvideo.com 

Website: http://www.rossvideo.com 

mailto:techsupport@rossvideo.com?Subject=Information%20Request&Body=Hi,%0D%0D
mailto:solutions@rossvideo.com?Subject=Information%20Request&Body=Hi,%0D%0D
http://www.rossvideo.com
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Introduction
A Word of Thanks
Thank you for choosing Ross Video Rio Replay as your replay server solution.

We are committed to providing you with the highest level of customer satisfaction possible. If, for any reason, you 
have questions or comments, please call Ross Video at +1-613-652-4886 or send us an e-mail at 
techsupport@rossvideo.com.

We hope that you visit our website www.rossvideo.com to stay up to date with ongoing software releases, join our 
customer forum, and learn more about the complete range of Ross Video products.

Note that software maintenance and extended warranties are available for your system to protect and extend the life 
of your investment. Our sales team is more than happy to provide further information on the plans available. 
Members of our sales team will promptly respond to e-mails sent to: solutions@rossvideo.com.

Again, thank you for your purchase of a Rio Replay solution from Ross Video. We are confident of your future 
pleasure with your choice.

Yours Sincerely,

Shawn Snider
Vice President of Production Workflow & Cloud Services

mailto:techsupport@rossvideo.com?Subject=Information%20Request&Body=Hi,%0D%0D
http://www.rossvideo.com
mailto:solutions@rossvideo.com?Subject=Information%20Request&Body=Hi,%0D%0D
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About This Guide
The Rio Replay User Guide serves as an in-depth guide to the product and covers all concepts users need to know in 
order to use Rio Replay. This guide is intended as a comprehensive reference manual for daily use in production 
workflows.

 NOTE:
The Rio Replay User Guide is intended for the sole use of authorized and licensed users of Rio Replay.

This guide contains the following chapters that cover the use of Rio Replay:

1. Introduction — Summarizes the guide and provides important terms and conventions.

2. Getting Started — Provides a broad overview of the server and included software.

3. Server Configuration — Summarizes how to configure the server depending on its hardware and user 
preferences.

4. Replay Setup — Summarizes how to set up the server to use the Control Panel and run replay events.

5. Rio Replay Import — Summarizes how to use the Rio Replay Import application to import media for use on 
the server.

6. Rio Replay Explorer — Summarizes how to use the Rio Replay Explorer application to operate the server 
during replay events.

7. Channel Transport Control — Summarizes how to use individual channel transports in the Rio Replay 
Explorer application.

8. Clip Library — Summarizes how to use the Clip Library in the Rio Replay Explorer application to manage 
media.

9. Replay Overview — Provides an overview of the Rio Replay Control Panel, as well as replay modes. 

10. Replay Events — Summarizes how to create, open, and edit replay events.

11. Replay Operation — Summarizes how to load clips and use playlists.

12. Export — Summarizes how to export clips from the Clip Library.

13. Remote Control Support — Summarizes how to use external devices to remotely control the server.

14. AsRun Log Report Creator — Summarizes how to use the AsRun Log Report Creator application to generate 
a report of what clips were played on the server.

15. Maintenance and Specifications — Provides important information regarding the maintenance of the server.

 NOTE:
Certain features may or may not be visible in your interface depending on the features purchased by your 
organization or permissions assigned by your administrator. Contact your Rio Replay administrator to request 
permission changes, or to purchase additional features from Ross Video.

If you have questions pertaining to the operation of Rio Replay, please contact us at the numbers listed in the 
section “Contacting Technical Support” on page 1–3. Our technical staff is always available for consultation, 
training, or service.

Documentation Conventions
Special text formats are used in this guide to identify parts of the user interface, text that a user must enter, or a 
sequence of menus and sub-menus that must be followed to reach a particular command.

Interface Elements
Bold text is used to identify a user interface element such as a dialog box, menu item, or button. For example:

In the Assets panel, click Delete.
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User Entered Text
Courier text is used to identify text that a user must enter. For example:

In the Language box, enter English.

Referenced Guides
Italic text is used to identify the titles of referenced guides, manuals, or documents. For example:

For more information, refer to the section “Managing Large Projects” in the Rio Replay User Guide.

Menu Sequences
Menu arrows are used in procedures to identify a sequence of menu items that you must follow. For example, if a 
step reads “File > Save As,” you would click the File menu and then click Save As.

Important Instructions
Star icons are used to identify important instructions or features. For example:

 NOTE:
After upgrading Rio Replay software, you must obtain feature licenses from Ross Video Technical Support 
before users can access Rio Replay features.

Contacting Technical Support
Technical Support is staffed by a team of experienced specialists ready to assist you with any question or technical 
issue.

Ross Video has technical support specialists strategically located around the globe to ensure a prompt response to 
technical inquiries. Our primary technical support center is located in Ottawa, Ontario, Canada. In addition, we 
have offices in The United Kingdom (London), Australia (Sydney), and Singapore with satellite locations in New 
York City, the Netherlands, and China. As we expand our presence globally, we are constantly evaluating other key 
locations to have a local technical support specialist in order to better service our customers.

North America

Our North America center located in Ottawa, Ontario, Canada and is open Monday to Friday 8:30 a.m. to 6:00 p.m. 
EST, with 24/7/365 on-call service after hours.

Our telephone number is: +1-613-686-1557

Toll free within North America: +1 833-859-0499

EMEA

Our EMEA center is open Monday to Friday 8:30 a.m. to 5:00 p.m. GMT. After hours support is provided by our 
North America location.

International toll free: +800 3540 3545

If the local support specialist is not available, your call will be transferred automatically to our North America 
center.

Australia

Our Sydney, Australia office is located in Alexandria, NSW.

Our local support telephone number is: 1300 007 677
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If the local support specialist is not available, your call will be transferred automatically to our North America 
center.

Online

E-mail: techsupport@rossvideo.com 

Website: Open a support ticket using the following link: https://support.rossvideo.com/

mailto:techsupport@rossvideo.com?Subject=Information%20Request&Body=Hi,%0D%0D
https://support.rossvideo.com/
http://www.rossvideo.com/support/tech-support.html
https://support.rossvideo.com/
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Getting Started
The server consists of a computer with advanced video processing, storage, and streaming capabilities. The server 
runs a Microsoft® Windows® IoT Enterprise LTSC operating system with pre-installed software applications for 
interacting with the video processing hardware.

Powering the System On/Off
The system powers on with the single power button located at the front of the chassis. When the power button is 
pressed, the system will boot up and launch Windows®.

To power the system off, perform the standard Windows® Shutdown procedure.

 WARNING:

Even with the system powered off, hazardous voltages are present inside the chassis. Disconnect both the primary 
and secondary power supplies before opening up the chassis.

Logging in to Windows®
The server comes with the Microsoft® Windows® operating system and all the required software pre-installed.

Refer to the Windows® help system for information on changing the password.

 NOTE:
Once you have logged in to the system, the video channels and serial control are all active. If you are using an 
external serial controller, that controller can now be used to control the video channels (including loading and 
playing clips).

Reviewing the Pre-Installed Software
The server comes pre-installed with all the software needed for operation and setup:

• Rio Replay Explorer — Provides a graphical interface to the operation of the server.
• Rio Replay Import — Allows you to import media files into the server.
• Rio Replay Config — Allows you to configure the hardware of the server.
• Rio Replay AsRunReport — Allows you to create a Report that contains all media playout from all channels of 

the video server.

 IMPORTANT:

Do not install any additional third party software applications onto the video server. Third party software 
applications that did not come pre-installed on your video server can place demands on system resources that may 
negatively impact real-time audio/video processing resulting in performance degradation in recording and/or 
playback. Install third party applications at your own risk.



Rio Replay User Guide (v10.2.0) Server Configuration • 3–1

Server Configuration
The Rio Replay Config application allows you to configure various aspects of your server. The number of channels, 
inputs, and outputs you have depends on the hardware installed in your server.

This chapter discusses the following topics:

• Configuring Channels
• Configuring Hardware Channels
• Configuring Video Formats
• Setting up Audio
• Setting up the Audio Router
• Setting up the Timecode
• Setting up the Channel Names
• Setting up the Quad Viewer
• Setting up TSL Tally
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Configuring Channels
The hardware channels can be set up in various ways, depending on the task the server needs to perform. These 
configurations are applied to all the channels in a group (ChA-D, ChE-H, ChI-L).

The following tables show channel allocations for the first four channels on the server (ChA-D) but the remaining 
groups are configured in the same way.

Table 3.1  Video-Only / Video+Key

Mode Description
V V V V (Mix) Four (4) background channel transports (no alpha). This is the setting to use for 

UHDTV1 operation.

VK VK (Mix) Two (2) keyer channel transports (video+alpha). Channel A carries the video and 
channel C carries the alpha for the first key and channel B carries the video and channel 
D carries the alpha for the second key.

VK V V (Mix) One (1) keyer channel transport (video+alpha) and two (2) background channel 
transports. Channel A carries the video and channel B carries the alpha. This 
configuration also allows the two video (V) channels to playout a playlist with mix 
transitions.

VK V V One (1) keyer channel transport (video+alpha) and two (2) background channel 
transports. Channel A carries the video and channel C carries the alpha.

V V VK Two (2) background channel transports and one (1) keyer channel transport 
(video+alpha). Channel B carries the video and channel D carries the alpha.

Table 3.2  ISO / Replay Groups

Mode Description
ISO2 + V V (Mix) Two (2) 2D cameras are recorded to the same clip ID on channels A and B. Channels C 

and D are the playback channels.

ISO3 + V Three (3) 2D cameras are recorded to the same clip ID on channels A-C. Channel D is 
the playback channel.

ISO4 Four (4) 2D cameras are recorded to the same clip ID. There are no playback channels.

ISO4 Four (4) 2D cameras are recorded to the same clip ID on channels A-D. Channels E and 
F are used for background channel transports. Channels G and H are playback channels. 
This configuration requires all eight (8) channels.

ISO4 Four (4) 2D cameras are recorded to the same clip ID on channels A-D. Channels E 
(video) and F (alpha) are used for a keyer channel transport. Channels G and H are 
playback channels. This configuration requires all eight (8) channels.

ISO5 Five (5) 2D cameras are recorded to the same clip ID on channels A-E. Channel F is 
uses for a background channel transport. Channels G and H are playback channels. This 
configuration requires all eight (8) channels.

ISO6 Six (6) 2D cameras are recorded to the same clip ID on channels A-F. Channels G and 
H are playback channels. This configuration requires all eight (8) channels.

ISO7 Seven (7) 2D cameras are recorded to the same clip ID on channels A-G. Channel H is 
the playback channel. This configuration requires all eight (8) channels.
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Configuring Hardware Channels
The number of hardware channels on your server depends on the configuration your organization purchased.

To Configure the Hardware Channels

1. Launch the Rio Replay Config application.

A prompt may open to allow the program to make changes. Click Yes.

2. Click the Channels tab.

 NOTE:
Your selections may appear different, depending on the number of channels you have.

ISO8 Eight (8) 2D cameras are recorded to the same clip ID on channels A-H. There are no 
playback channels. This configuration requires all eight (8) channels.

ISO9 Nine (9) 2D camera are recording to the same clip ID on channels A-I. Channels J-L are 
playback channels. This configuration requires all twelve (12) channels.

ISO10 Ten (10) 2D camera are recording to the same clip ID on channels A-J. Channels K-L 
are playback channels. This configuration requires all twelve (12) channels.

ISO11 Eleven (11) 2D camera are recording to the same clip ID on channels A-K. Channel L is 
the playback channels. This configuration requires all twelve (12) channels.

ISO12 Twelve (12) 2D camera are recording to the same clip ID on channels A-L. There are no 
playback channels. This configuration requires all twelve (12) channels.

Table 3.3  Super Slow Motion Cameras

Mode Description
2X Super Slow 
Motion Camera 

One (1) 2-times slow motion channel transport.

3X Super Slow 
Motion Camera 

One (1) 3-times slow motion channel transport.

4X Super Slow 
Motion Camera 

One (1) 4-times slow motion channel transport.

6X Super Slow 
Motion Camera 

One (1) 6-times slow motion channel transport. This configuration requires all eight (8) 
channels.

8X Super Slow 
Motion Camera 

One (1) 8-times slow motion channel transport. This configuration requires all eight (8) 
channels.

SSM-2X ISO3 Two (2) slow motion camera inputs per channel with three (3) channels.

SSM-3X ISO2 Three (3) slow motion camera inputs per channel with two (2) channels.

SSM-2X ISO4 Two (2) slow motion camera inputs per channel with four (4) channels.

SSM-3X ISO3 Three (3) slow motion camera inputs per channel with three (3) channels.

SSM-2X ISO5 Two (2) slow motion camera inputs per channel with five (5) channels.

Table 3.2  ISO / Replay Groups

Mode Description



3–4 • Server Configuration Rio Replay User Guide (v10.2.0)

3. Select the video processing mode and how you want the channels grouped. Refer to the tables in “Configuring 
Channels” on page 3–2 for information about these options.

4. Select your preferred option that includes the default alpha (key) output that is used on a video, and the key 
channel transport when no alpha channel is present in the clip or no clip is loaded.

• Output BLACK on key output — The key (alpha) channel outputs a full frame of internally generated 
black.

• Output WHITE on key output — The key (alpha) channel outputs a full frame of internally generated 
white. Use this selection if the output is going to a switcher as an auto-select key. The full-frame white alpha 
will force the entire video image onscreen.

5. Select the default clip that will be used for unloaded channels.

• Internal Color Bars — A frame of internally generated color bars.
• Internal Full Frame of Black — A full frame of internally generated black.
• Stored Clip/Still from Clip Library — Allows for a specific file to be chosen for use instead of color bars 

or a black frame.
• Auto Loop-Play Motion Clip — A check box that can be selected to automatically loop the stored clip.

6. Click Apply.
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Configuring Video Formats

 NOTE:
1080p 50 / 59.94 Hz supports 3G Level A. 3G Level B is not supported.

Configuring the Video Format
The server can only operate in one video format at a time. All channel transports will play and record in the same 
format.

 NOTE:
Not all video resolutions and frequencies are compatible. Some selections will be grayed out if they are not 
compatible.

To Configure the Video Format

1. Launch the Rio Replay Config application.

A prompt may open to allow the program to make changes. Click Yes.

2. Click the Video tab.

3. In the Video Reference Frequency area, select the frequency you want the server to operate in.

4. In the Video Resolution area, select the video resolution you want the server to operate in.

The available resolutions depend on the frequency you have selected.

Table 3.4  Available Video Formats

Format Frequency
720p 50 / 59.94 Hz

1080i 50 / 59.94 Hz

1080p 50 / 59.94 Hz
60 / 30 / 29.97 / 25 / 24 / 
23.98 Hz
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5. In the Video Reference Source area, select the type of input reference signal that the server is using. This is the 
video signal that is connected to the REF IN HD-BNC on the back of the server.

The reference input should be connected to Video Board #1. The server will sync the reference to all boards 
internally.

 NOTE:
You should only use Free Run when the server is not receiving video from, or outputting video to, another 
device.

 IMPORTANT:
If you select Tri-Level External Reference or Bi-Level External Reference with no valid reference signal 
coming into the server, you will get corrupt video on all outputs.

6. In the Horizontal Phase area, select a timing offset for the video output relative to the reference timing.

7. In the Net Video area, check or uncheck the Enable Network Video box to select whether the server can share 
clips with other servers on the same network. All servers must have the same hardware and be operating in the 
same video format.

Clips from another server can be loaded and included in a local playlist. Clips are not copied between servers. 
The clip is played across the network between servers. The network connection must be maintained to use the 
clip on a remote server.

8. Click Restart Replay. A confirmation dialog box opens.

9. Click Restart Replay to restart the server application and services with the new settings.

10. Click OK when the application and services have restarted to dismiss the window.

Setting up Audio
You can select the number of audio channels to record, which sources to use, and which audio channel to monitor 
from the analog audio out headphone jack. The number of AES digital audio inputs and outputs depends on the 
server your organization purchased.

Configuring the Audio Setup
To Configure the Audio Setup

1. Launch the Rio Replay Config application.

A prompt may open to allow the program to make changes. Click Yes.

2. Click the Audio tab.
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3. In the Audio Tracks area, select the number of audio tracks to record.

• 2 track audio — Record two tracks of audio.
• 4 track audio — Record four tracks of audio.
• 8 track audio — Record eight tracks of audio.
• 14 track audio — (Software option) Record fourteen tracks of audio.

4. In the Audio Tracks in an ISO Clip area, select the number of audio tracks to record per input channel when 
recording in ISO mode.

• 2 track audio accompanies each video input — Record two tracks of audio per input channel when 
recording in ISO mode.

• 4 track audio accompanies each video input — Record four tracks of audio per input channel when 
recording in ISO mode.

• 8 track audio accompanies each video input — Record eight tracks of audio per input channel when 
recording in ISO mode.

• 14 track audio accompanies each video input — Record fourteen tracks of audio per input channel when 
recording in ISO mode.

5. In the Audio Muting Policy area, select how the audio output (AES, embedded, and analog audio out) is 
muted during playback.

• Mute everything except 100% play speed and JOG STEP — Audio is muted at all play speeds except 1× 
(100%) and during single-frame jogging.

• Mute everything except 100% play speed. Mute JOG STEP — Audio is muted at all play speeds except 
1× (100%).

• Mute when speed is not in the range 85% through 115% of play speed — Audio is muted at all play 
speeds except in the range of 85% to 115% play speed.

• Mute when playback speed exceeds 200% play speed — Audio is muted only when play speed exceeds 
2× (200%).

6. In the Analog Audio Monitor area, select the channel transport audio that you want to monitor on the 
corresponding board’s audio jack. Only audio channels 1 and 2 are available on the analog audio output port.

7. Click Apply.
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Setting up the Audio Router
There are two integrated audio routers built into the server. An input router that sends audio from an audio input to 
any channel transport, and an output router that sends the audio from a channel transport to any audio output. The 
number of audio inputs and outputs depends on the options you have installed in your server.

Audio sources and destinations include embedded audio and AES audio on the TASCAM® AES-59 DB25 ports on 
the back of the server.

Configuring the Audio Router
The Audio Router tab contains two tabs. The Audio Input Router tab allows you to set the audio channel that is 
recorded on the server. The Audio Output Router tab allows you to set which audio channels are played from the 
server.

To Configure the Audio Router

1. Launch the Rio Replay Config application.

A prompt may open to allow the program to make changes. Click Yes.

2. Click the Audio Router tab.

 If the audio routing on an input or output has been changed, a dot is shown next to the name on the tab.

3. Click the Audio Input Router tab.

4. Click the tab for the record channel that you want to route the audio channel to.

5. In the ChX Recorder Track 1 row, select the source channel input (ChX Input or TASCAM AES Input) and 
the audio channel (Track #) from the input that you want to record on channel 1 of the clip.

Repeat this step for all of the remaining record channels.

 TIP:
Click NORMALIZE ALL ChX Input Routes to reset all the input audio channels to their default record 
channel assignment.

6. Click the Audio Output Router tab.
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7. Click the tab for the channel output into which you want to route audio channels.

8. In the ChX Audio Output Track 1 row, select the source channel player (ChX Player) and the audio channel 
(Track #) from the player that you want to route to channel 1 of the output video stream.

Repeat this step for all of the remaining output audio channels you want to assign a source to.

 TIP:
Click NORMALIZE ALL ChX Output Routes to reset all the player audio tracks to their default output track 
assignment.

9. Click Apply.

Setting up the Timecode
The selected timecode information that is recorded with the video can be overlaid on the output video stream of the 
server. This can be the time of day linear timecode (LTC) coming into the server, or the embedded ancillary 
timecode (ATC) in the video stream being recorded.

 IMPORTANT:
When you turn the timecode overlay on, it is shown over the image on the video output.

To Configure the Timecode

 NOTE:
The timecode overlay is only visible on the video output and will not appear in the recorded video.

1. Launch the Rio Replay Config application.

A prompt may open to allow the program to make changes. Click Yes.

2. Click the Timecode tab.
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3. In the Timecode Input Source area, select the timecode source for each channel.

• Time of Day LTC In — The LTC signal coming into the server.
• ATC In — The embedded digital timecode in the video source.

4. In the Replace ATC Output with Time Remaining area, select the video channels that you want the normal 
count-up ATC timecode to be replaced with the count-down (time-remaining) ATC timecode.

5. In the Replace MultiViewer Timecode with Time Remaining area, select the video channels that you want 
the normal timecode to be replaced with the count-down (time-remaining) timecode.

6. In the Timecode Overlay on Video Output area, select whether the timecode is displayed on the video output 
for each channel.

• Off — The timecode is not shown on the video output stream.
• On in EE and Record — The timecode is only shown when in EE mode or when the channel is recording.
• Always On — The timecode is always shown on the video output stream.

7. In the Timecode Overlay Position And Size area, use the Left/Right and Top/Bottom sliders to position the 
timecode overlay on the background video source, and use the H Small/H Large and V Small/V Large sliders 
to adjust the size of the timecode text.

8. In the Clips Beyond 24-Hour Timecode area, select whether the server can record a clip that is longer than 24 
hours in length.

 NOTE:
External devices controlling the server over VDCP or AMP will not support timecode over 24 hours. You will 
not be able to seek beyond the 24 hour point as the timecode restarts again.

9. Click Apply.

Setting up the Channel Names
You can assign a custom name to each channel transport to help identify the server it is on or what it is used for. 
Names are shown at the far right of each channel transport in Rio Replay Explorer and on each box in the HD-SDI 
Quad Viewer output.
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To Assign Names to Channels

1. Launch the Rio Replay Config application.

A prompt may open to allow the program to make changes. Click Yes.

2. Click the Ch Names tab.

3. Enter a new name for each channel transport as required.

Leave the name field blank to remove the channel name from the channel transport and Quad Viewer.

4. Click Apply.

Setting up the Quad Viewer
The Quad Viewer output can display either the Quad Viewer or a Count Down display. For the Quad Viewer display 
you can adjust the transparency of the overlay text on the Quad Viewer output.

 NOTE:
This setup information applies to the Quad Viewer external outputs only. The internal Multi-Viewer in the Rio 
Replay Explorer is not affected.

Quad Viewer Display
The Quad Viewer outputs show the audio and video output of each group of channel transports in the server. 
Channels A-D are shown on output Quad ABCD, channels E-H are shown on output Quad EFGH, and channels I-L 
are shown on output Quad IJKL. The appearance of the Quad Viewer depends on the number of channels installed 
and how they are configured.

• The channel, audio meters, and status are shown along the top of each quadrant.
• The clip name and timecode are shown along the bottom of each quadrant.
• The position of the channel label can be adjusted.
• The opacity of the overlay text can be adjusted.
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Configuring the Count Down Display
The Count Down Display shows the program output for Live EE, Playback, or Playlist AIR.

• The channel label and audio meters are shown at the top of the each box.
• The current timecode is shown at the bottom of each box.

To Configure the Count Down Display

1. Launch the Rio Replay Config application.

A prompt may open to allow the program to make changes. Click Yes.

2. Click the Quad Viewer tab.

3. In the Output Display area, select Count Down Display.

4. In the drop-down boxes in the Output Display area, select which channels you want to show the Count Down 
Display.

5. In the Clip Information Overlay area, adjust the opacity of the clip information text and background of the 
text. These overlays are shown in the corners of each Quad Viewer quadrant.

Select one of the Overlay Presets to quickly set both the text and background opacity.

• Use the Text Opacity slider to adjust the transparency of the overlay text.
• Use the Background Opacity slider to adjust the transparency of the background behind the overlay text.

6. In the Channel Label Overlay area, select the opacity, position, and size of the channel information text.

• Opacity — Select the transparency of the label. Select Off to disable the channel label overlay.
• Position — Select the position for the label in the quadrant.
• Height — Select the size of the label.

7. Click Apply.

Setting up TSL Tally
The server can receive TSL messages from a downstream device to tally the channels on the server.
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For example, when a production switcher takes the Channel A source from the server on-air, the switcher sends a 
signal back to the server telling it that Channel A is on-air and should be tallied.

 NOTE:
Tally information is shown on the Channel Label of a channel in Rio Replay Explorer and the Quad Viewer 
output. You must have a Channel Label assigned to the channel for the tally information for that channel to be 
displayed (refer to the section “Setting up the Channel Names” on page 3–10). The Channel Label overlay 
must be visible on the Quad Viewer output for the tally information to be visible (refer to the section “Setting up 
the Quad Viewer” on page 3–11)

The tally status is shown using the color of the background of the Channel Label.

• Gray — The channel is not on program or preview.
• Red — The channel is on program.
• Green — The channel is on preview.
• Amber — The channel is being recorded by a downstream device.

 NOTE:
TSL tally colors are set by how the protocol was implemented in the source device and may not be as listed 
above. Check with the device that is sending the TSL information to the server for information on how the 
protocol was implemented.

Configuring the TSL Tally Input
Tally information sent to the server over ethernet using the TSL protocol is used to show red, green, gray, and 
amber tallies on the channel labels. You will need the IP address and port of the device sending the tally 
information, as well as the screen mapping.

To Configure the TSL Tally Input

1. Launch the Rio Replay Config application.

A prompt may open to allow the program to make changes. Click Yes.

2. Click the Tally tab.

3. In the Server Address field, enter the IP address of the device that is sending the TSL tally information.



3–14 • Server Configuration Rio Replay User Guide (v10.2.0)

4. In the Server Port field, enter the port number on the device that the server is listening to.

5. In the Connection Type area, select the type of ethernet communication you want to use.

• UDP — Select if you connect to the tally system using the UDP protocol.
• TCP Server — Select if you connect to the tally system as a server using the TCP protocol.
• TCP Client — Select if you connect to the tally system as a client using the TCP protocol.

6. In the Tally Protocol area, select the TSL protocol the tally system is using.

• TSL UMD V3.1 — Select if the tally server is using the TSL tally protocol v3.1.

7. Set up the tally interface as required:

8. Click Apply.

 

Protocol Settings
TSL v3.1 

Assign Preview Tally Select which indicator is lit when a channel transport is tallied on preview.

Assign Preview Tally Color Select the color to use when a channel transport is tallied on preview.

Tally Index Number Enter the tally ID that is assigned on the tally server to the input on the 
server.
 TIP: Refer to the device that you are receiving the tally information 
from for the ID that is assigned to the video input that is connected to the 
output of each channel on the server.
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Replay Setup
To operate the server as a replay server, you must configure channels in a replay (ISO) mode, connect a Control 
Panel, and open a replay event. Depending on the replay (ISO) mode you have selected and the number of channels 
in your server, you can run both server and replay operations at the same time.

This chapter discusses the following topics:

• Connecting the Control Panel
• Setting up the Server for Replay
• Configuring the User Setup
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Connecting the Control Panel
The Control Panel powers on when the power cable has been connected and the power switch has been set to the 
On position. The Control Panel connects to the server through a standard CAT5e Ethernet cable. When the unit is 
connected, the LCD screens will illuminate. A connection to the server and an open replay event are both required 
to operate the Control Panel.

Figure 4.1  The rear panel of the Control Panel

Setting up the Server for Replay
You must configure the hardware channels for one of the ISO modes that meet your requirements. This 
configuration is based on the number of channels you have and how you want to use them.

Use the information in the following table to pick a mode.

Table 4.1  ISO Modes: 8-Channel

Cameras
PGM/PVW Channels in 

Replay Mode
8-Channel 

ISO2 2 2

ISO3 3 2

ISO4 4 2

ISO5 5 2

ISO6 6 2

ISO7 7 1

ISO8 8 0
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To Configure the Server for Replay

 NOTE:
You must connect the Control Panel to the server before you try to configure the server. The server will detect the 
Control Panel and allow you to assign channels to it.

1. Launch the Rio Replay Config application.

A prompt may open to allow the program to make changes. Click Yes.

2. Click the Channels tab.

3. Select the ISO mode for the number of cameras and playout channels that you require.

Table 4.2  ISO Modes: 12-Channel

Cameras
PGM/PVW Channels in 

Replay Mode
12-Channel 

ISO2 2 2

ISO3 3 2

ISO4 4 2

ISO5 5 2

ISO6 6 2

ISO7 7 2

ISO8 8 2

ISO9 9 2

ISO10 10 2

ISO11 11 1

ISO12 12 0
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4. Click Apply.

5. Click the Control Panel tab.

6. In the Number of control panels assigned to this Replay field, enter the number of Control Panels you want 
to use.

7. In the Control Panel Config 1 area, click the Control Panel Identifier button and select the Control Panel 
that you want to assign to channels.

Each Control Panel is identified by its MAC address, which can be found on a label located on the back of the 
unit.

8. In the Playback channels area, select the channels that you want to use for playout from this panel.

9. Repeat this for each Control Panel you want to connect to the server.

10. Click Apply.

Configuring the User Setup
In the Rio Replay Explorer application, the User Settings allow you to customize the replay function to the activity 
or sport you are recording and your own personal preferences.

Opening User Settings
To open the User Settings, press SHIFT + MENU on the Control Panel while a replay event is open. Use the jog 
wheel to highlight a setting, then press ENTER to change the Current Value. Press SHIFT + MENU again to 
close the User Settings.

The User Settings are listed in the following table:



Rio Replay User Guide (v10.2.0) Replay Setup • 4–5

Table 4.3  User Settings

Group Parameter name Default Value Range Description
PGM LIVE EE - Auto 

Gang
OFF OFF/ON Whether GANG is 

automatically 
selected when 
LIVE-EE selected.

PGM PGM Selection 
Release Gang

ON OFF/ON Whether GANG is 
automatically 
deselected when a 
playout channel is 
selected.

PGM LIVE EE - Reset 
Cam

OFF OFF/ON Whether the 
preferred camera 
angle for each 
playout channel is 
selected when 
LIVE-EE is 
selected.

PGM PGM/PVW Order PGM/PVW PGM/PVW
PVW/PGM

Swaps the position 
of the PGM and 
PVW windows.

PGM PGM1 Preferred 
CAM

CAM 1 CAM 1 to CAM 12 The preferred 
camera angle for 
playout channel 1.

PGM PGM2 Preferred 
CAM

CAM 2 CAM 1 to CAM 12 The preferred 
camera angle for 
playout channel 2.

PGM PGM3 Preferred 
CAM

CAM 3 CAM 1 to CAM 12 The preferred 
camera angle for 
playout channel 3.

PGM PGM4 Preferred 
CAM

CAM 4 CAM 1 to CAM 12 The preferred 
camera angle for 
playout channel 4.

Clips Auto Mark IN 00:00:03:00 00:00:00:01 to 
00:59:55:00

The timecode that 
is subtracted from 
the POI timecode 
when saving a clip 
that has no in point.

Clips Auto Mark Out 00:00:05:00 00:00:00:01 to 
00:59:55:00

The timecode that 
is added to the POI 
timecode when 
saving a clip that 
has no out point.

Clips Switch to IN - Clips ON ON/OFF Whether, when 
using a softkey to 
switch to a clip, it 
cues to the IN 
point.
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Clips Clip Default Name Empty IN Timecode
Empty
Camera Angle
Camera Name
Camera # & Name

The source of the 
name that is applied 
to new clips.

Clips Auto Export new 
Clips

OFF OFF/ON Whether new clips 
are automatically 
exported.

Clips & Replay Take Transition MIX MIX/CUT The type of 
transition that is 
applied when 
TAKE is pressed in 
Playlist mode.

Clips & Replay Take Transition 
Duration

00:00:00:10 00:00:00:01 to 
00:00:02:00

The duration of the 
transition.

Clips & Replay Freeze on IN - 
Playback & Clips

OFF OFF/ON Whether the clip 
plays or not when 
the in point is 
reached.

Clips & Replay Freeze on OUT - 
Playback & Clips

OFF OFF/ON Whether the clip 
stops playing when 
the out point is 
reached.

Playlist Playout Always use 
PVW/PGM for 
Playlist Playout

ON OFF/ON Whether a playlist 
will always play 
out of two channels 
(PVW/PGM) when 
on-air in 
PLAYLIST mode.

Playlist Playout Enable Jog in 
Playlist Playout

ON ON/OFF Whether the Jog 
Wheel is enabled in 
Playlist Playout 
mode.

Playlists Playlist Auto-Fill 
by Clip name

Auto Fill OFF Auto Fill PL name 
and #
Auto Fill PL name 
only
Auto Fill PL # only

Choose if clips are 
automatically 
appended to a 
playlist if the clip’s 
name is also in the 
playlist’s name.

Playlists Auto-Fill melt all 
Playlist

99 1 to 99 When a clip is 
saved and renamed, 
the clip is also 
saved to the 
selected playlist 
number.

Cameras Number of primary 
camera windows

6 1 to 10 Sets the number of 
primary camera 
windows.

Table 4.3  User Settings

Group Parameter name Default Value Range Description
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Cameras Primary camera 
windows begin 
with

CAM 1 CAM 1 to CAM 12 Sets the CAM 
number assigned to 
primary camera 
windows.

Jog & T-Bar JOG MAX Speed 10X 1X to 99X The maximum 
speed multiplier for 
the Jog Wheel.

Jog & T-Bar FAST JOG MAX 
Speed

15X 10X to 99X The maximum 
speed multiplier for 
the Jog Wheel in 
Fast Jog mode.

Jog & T-Bar Jog Brake OFF OFF/ON When toggled ON, 
small movements 
of the Jog Wheel 
are ignored so that 
playback is not 
unintentionally 
stopped.

Jog & T-Bar T-BAR Secondary 
Top Speed

2X 1X to 99X The maximum 
speed multiplier for 
the T-bar when it is 
in the top position.

Jog & T-Bar T-BAR Secondary 
Bottom Speed

0X 0X to -99X The minimum 
speed multiplier for 
the T-bar when it is 
in the bottom 
position.

Keyboard Keyboard - Auto 
Load Prev / Next 
Clip

OFF OFF/ON Whether the 
previous or next 
clip is 
automatically 
loaded when CLIP 
PLAY mode is 
active.

Keyboard Keyboard - Space 
Bar - Play / Pause

OFF OFF/ON Whether the space 
bar on the keyboard 
can be used to play 
or pause clips.

Confirm Delete Pop-up - Confirm 
Delete - Clips & PL 
items

ON ON/OFF Whether a pop-up 
notification will 
appear to confirm 
the deletion of clips 
and playlist items.

Confirm Delete Pop-up - Confirm 
Delete - Clips Cut 
(CTRL+X)

OFF OFF/ON Whether a pop-up 
notification will 
appear to confirm 
that the selected 
clip will be cut 
using CTRL+X.

Table 4.3  User Settings

Group Parameter name Default Value Range Description
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Confirm Delete Pop-up - Confirm 
Delete - Playlists

ON ON/OFF Whether a pop-up 
notification will 
appear to confirm 
the deletion of 
playlists.

OSD PGM1 Audio meter 
position

Right Right or Left The position of the 
Audio Meter for 
channel 1.

OSD PGM2 Audio meter 
position

Right Right or Left The position of the 
Audio Meter for 
channel 2.

OSD PGM3 Audio meter 
position

Right Right or Left The position of the 
Audio Meter for 
channel 3.

OSD PGM4 Audio meter 
position

Right Right or Left The position of the 
Audio Meter for 
channel 4.

OSD PGM1 Audio meter 
Opacity

50% Off/25%/50%/75%/
90%

The opacity of the 
Audio Meter for 
channel 1.

OSD PGM2 Audio meter 
Opacity

50% Off/25%/50%/75%/
90%

The opacity of the 
Audio Meter for 
channel 2.

OSD PGM3 Audio meter 
Opacity

50% Off/25%/50%/75%/
90%

The opacity of the 
Audio Meter for 
channel 3.

OSD PGM4 Audio meter 
Opacity

50% Off/25%/50%/75%/
90%

The opacity of the 
Audio Meter for 
channel 4.

Audio Headphones 
Monitor - Left

1 1 to 16 The audio track 
used for the left 
speaker on the 
headphone output.

Audio Headphones 
Monitor - Right

2 1 to 16 The audio track 
used for the right 
speaker on the 
headphone output.

Audio Headphones 
Monitor - Volume

80% 0% to 100% The volume, as a 
percentage, for the 
headphone output.

Visibility Panel Buttons 
Brightness

100 0 to 100 The brightness of 
the buttons and 
displays on the 
Control Panel.

Table 4.3  User Settings

Group Parameter name Default Value Range Description
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Visibility Inactive Windows 
Brightness

50 20 to 80 The amount 
windows will be 
dimmed when 
inactive.

PGM PGM1 - Frame 
color

Red 14 options The color of the 
frame around 
playout channel 1.

PGM PGM2 - Frame 
color

Blue 14 options The color of the 
frame around 
playout channel 2.

PGM PGM3 - Frame 
color

Orange 14 options The color of the 
frame around 
playout channel 3.

PGM PGM4 - Frame 
color

Green 14 options The color of the 
frame around 
playout channel 4.

Table 4.3  User Settings

Group Parameter name Default Value Range Description
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Rio Replay Import
The Rio Replay Import application converts all imported media files to the current video output format that the 
server is operating in.

For example, if the server is currently operating in the 1080i 59.94Hz video format, then all imported media files 
are converted to 1080i 59.94Hz even if they are in a different video format.

 NOTE:
Ancillary data is preserved from the import of MXF files in systems with AVC-Intra native recording formats.

This chapter discusses the following topics:

• Supported Import Transcoding
• Importing Media Files
• Adding Watch Folders
• Configuring Rio Replay Import
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Supported Import Transcoding
The Software Transcoder in Rio Replay Import uses FFmpeg™ for the decoding operation.

Supported Video and Audio Media Files

 NOTE:
Other formats may be supported by Rio Replay Import, but have not been recently tested for compatibility.

Importing Media Files
You can transcode a media file of a different format to a clip that can be played in the server.

 NOTE:
You can close the Rio Replay Import application at any point during an import to stop the process. When you 
start the Rio Replay Import application again, it will detect the import queue and prompt you to resume.

To Import Media Files

1. Launch the Rio Replay Import application.

The Select Import Method window opens.

2. In the Import method drop-down, select how you want to import the media file.

• Software Transcoder — Use the software based transcoder to import the media file that is in a different 
media format than your hardware.

• Native Import Only: No Transcoding — Import the media file that is in the native media format for your 
hardware. Select this if the file you are importing is in the AVC-Intra 100.mov/.mxf format or uses the 
Software Transcoder for any published codec. No channels are consumed for either of these operations.

Table 5.1  Video and Audio Media Files for Import

Codec Import Transcoding
AVC-Intra MXF Op1a / Native .clip No – Native codec

ProRes 422 MXF Op1a / MOV Yes

ProRes 422 HQ MXF Op1a / MOV Yes

ProRes 422 LT MXF Op1a / MOV Yes

ProRes 4444 MXF Op1a / MOV Yes

DNxHD 120/145/240/290 MXF Op1a / MOV Yes

XDCAM50 422 MXF Op1a / MOV Yes

XDCAM EX MXF Op1a / MOV Yes

MPEG-4 10Mb/s AVI No Yes
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• AVC-Intra 100.mov/.mxf — If your server is equipped with the AVC-Intra video hardware.

The Rio Replay Import window opens.

3. Click Import From and select the folder that the media files you want to import are located in.

If you want to point the import application to a network drive, you must map that drive in Windows® before 
you can select it as a source.

4. Click Select Folder.

5. Click Destination and select the H:\Video folder, or a folder below it, on the media drive.

 NOTE:
The destination must be under the H:\Video folder on the media drive or the imported files will not be available 
to the server.

6. Click Select Folder.

7. Click the green add files (+) button. In the window that opens, select the media files that you want to import.

8. Click Open.

 NOTE:
If you want to remove files from the import list, select the files and click the red remove files (-) button. The files 
are not deleted, only removed from the import queue.

 NOTE:
You can change the order that the files are imported by selecting the file(s) you want to move and click the up or 
down arrow buttons on the right of the window. The file(s) are moved up or down in the list. You can also drag 
and drop the files to order the files.

Adding Watch Folders
You can create multiple watch folders that the import utility will monitor. It will automatically import any media 
files that are modified or copied into the watch folders.

 NOTE:
The Rio Replay Import application must be running for the watch folder functionality to work. You can set up 
the application to automatically launch and start the watch folder function when the server is powered on.
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To Add a Watch Folder

1. Launch the Rio Replay Import application.

2. In the Import Method list, select the how you want to import the media file.

• Software Transcode — Use the software based transcoder to import a media file that is in a different media 
format than your hardware.

• Native Import Only: No Transcoding — Import a media file that is in the native media format for your 
hardware.

Select Native Import Only if the file you are importing is one of the following. Otherwise, use Software 
Transcode for any published codec. No channels are consumed for either of these operations.

• AVC-Intra 100.mov/.mxf — If your server is equipped with the AVC-Intra video hardware.

The Rio Replay Import window is shown.

3. Click File > Watch Folders....

The Watch Folders window opens.

4. Click Add Watch Folder... to open a new window. Click Browse... to select the folder that you want Rio 
Replay Import to watch. The folder can be on the local media drive or a network drive.
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5. Click Select Folder to add the folder to the watch list. Repeat for any additional folders you want Rio Replay 
Import to watch.

 NOTE:
You can remove a folder from the watch list by selecting it and clicking Remove.

6. Click OK.

7. Select Enable Watch Folder to start importing from the watch folders.

Configuring Rio Replay Import
The Rio Replay Import configuration menus allow you to change the destination folder, set how the RGB color 
space is interpreted, the raster size of the imported video, set up a watch folder, and set an autostart behavior.

To Configure Rio Replay Import

1. Launch the Rio Replay Import application.

2. In the Import Method list, select the how you want to import the media file.

• Software Transcode — Use the software based transcoder to import the media file that is in a different 
media format than your hardware.

• Native Import Only: No Transcoding — Import the media file that is in the native media format for your 
hardware.

Select Native Import Only if the file you are importing is one of the following or use the Software 
Transcoder for any published codec. No channels are consumed for either of these operations.

• AVC-Intra 100.mov/.mxf — If your server is equipped with the AVC-Intra video hardware.

The Rio Replay Import window is shown.
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3. Click Edit > Configure.

4. The Import Configuration window opens.

5. Click the Destination tab and click Change to select a new destination folder for import.

6. Click the Color tab and select how the RGB luminance color range is interpreted when a file is imported.
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• Normal — Color luminance range is scaled from 0 to 255. Select this option if you are importing a media 
file with alpha (key). The alpha may not import properly otherwise.

• Prescaled to 10-235 — Color luminance range is scaled from 10 to 235. Do not use this option when 
importing a clip with an alpha channel (VK clips). The alpha channel will not import properly. Use Normal 
when importing a clip with an alpha channel.

 TIP:
If the black levels of your imported media files appear crushed or the white levels do not appear as bright as 
expected, try selecting the opposite mode.

7. Click the Watch tab and set the amount of time the system will wait after it has detected a new file in the watch 
folder and how often it polls remote file servers. These settings are used in conjunction with the AutoStart 
configurations and the watch folder selection.
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• File Settle Time — the length of time the import application will wait after a file has been modified before 
starting to import it. If the media files are being rendered directly into the watch folder, set a long wait time. 
If the watch folder is being used for drag and drop, set a short wait time.

• Remote Fileserver Rescan Interval — the length of time the import application waits to poll an external 
server for changes. This setting is ignored if the external server is running a Windows® operating system.

8. Click the AutoStart tab and select whether the Rio Replay Import application is started automatically, and 
whether the selected folders are watched.

• Start importer 30 seconds after login — The Rio Replay Import application will be started 30 seconds 
after you log into Windows®.

• Enable watch folders at login — The watch folder functionality will start automatically with Rio Replay 
Import.
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• Import Channel — Select the channel transport to be used for import when the import application starts 
automatically.
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Rio Replay Explorer
Rio Replay Explorer is a Windows® application that provides a graphical interface to the operation of the server. 
Although this application allows you to control the operation of the server, it does not need to be running for the 
server to operate. You can quit Rio Replay Explorer at any time without affecting any of the active real-time video 
and audio recording and playback operations.

Figure 6.1  Rio Replay Explorer

The Library, MultiViewer, Export Editor, and Export Queue buttons at the top of the window allow you to 
quickly switch between the Clip Library, the MultiViewer, and the export modes. A bar will appear at the bottom of 
the window to provide status updates on various services running on the server.

This chapter discusses the following topics:

• Logging in to Rio Replay Explorer
• Managing Accounts
• Setting up Physical Channels
• Setting up Audio Meters
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Logging in to Rio Replay Explorer
When you launch Rio Replay Explorer, you have the option of logging in as an administrator, privileged user, or 
guest user. Each of these users have specific privileges that are assigned by the administrator account.

• Administrator — Full access to all features of the application and can set the privileges for the other account 
types. This account is password protected by default.

• Privileged User — The default account type for using the application. This account is not password protected by 
default.

• Guest User — A secondary user account if you want to give limited access to the application. This account is not 
password protected by default.

To Log In to Replay Explorer

1. Open the Rio Replay Explorer application.

The Rio Replay Explorer Login window opens.

2. In the Login Type box select the type of account you want to log in as.

• Administrator 
• Privileged User 
• Guest User 

3. If required, enter a password in the Enter Password field.

• Administrator — The default password is multiflex.
• Privileged User — There is no password by default.
• Guest User — There is no password by default.

4. Click OK.

The Rio Replay Explorer opens.
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Managing Accounts
The administrator account has access to all of the features of the server, as well as the ability to assign privileges to 
the other accounts.

Setting Account Permissions
The different types of accounts can have different permissions. The Administrator account can set the permissions 
for other types of accounts.

To Set Account Permissions

1. Log into Rio Replay Explorer as the Administrator.

2. Click Configure > General Configuration and click the Permissions tab.

3. Select the permissions you want assigned to each account.

The Guest User account cannot have permission to set passwords or set user permissions.

4. Click OK to save the changes.

Setting Account Passwords
Only the Administrator and Privileged User accounts can have a password.

To Set Account Passwords

1. Log into Rio Replay Explorer as the Administrator.

2. Click Configure > General Configuration and click the Passwords tab.
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3. Enter the new password for the account you want to set the password for. Passwords can use letters, numbers, 
and special characters, and are case-sensitive.

If the Privileged User password field is left blank, you will not be prompted to enter a password when logging 
in with that account.

4. Click OK.

Setting up Physical Channels
The server comes pre-configured with the channel transports assigned to physical channels on the same server. You 
can also assign physical channels from other servers to the channel transports on the server.

Assigning Channel Transports to Physical Channels
To Assign Channel Transports to Physical Channels

1. Click Configure > General Configuration and click the Channels tab.

You may have to log in with a different account if your current account does not have the relevant permissions.
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2. On the left side of the window, use the drop-down list to select the server that you want to assign a channel 
transport to. The number of channel transports that are available depends on the server model you have.

3. On the right side of the window, use the drop-down list to select the channel transport that you want to assign to 
the server.

Setting up Audio Meters
Audio meters can be shown as an overlay on the Multi-Viewer. You can adjust the position and transparency of the 
audio meters all at once, or individually.

 NOTE:
The number of channels shown in the audio meter depends on the number of audio channel in the clip. The 
number of audio channel in a clip is applied when the clip is recorded or imported and is based on the Audio 
Tracks settings from the Engineering Setup.

Configuring the Audio Meter for a Channel Transport
Each channel transport has an audio meter overlay on the Multi-Viewer output.

To Configure the Audio Meter for a Channel Transport

1. Click Configure > General Configuration and click the Audio Meters tab.

You may have to log in with a different account if your current account does not have the relevant permissions.
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You can also click Audio Meters on the top left corner of the Multi-Viewer. This does not require you to log 
in as an administrator.

To toggle audio meters on and off in the Multi-Viewer, press ALT+M.

2. Select the Apply Changes to ALL Channels box to have your selections applied to all channel transports.

3. Click the Left field and select where you want the audio meters to be positioned.

4. Click the 50% field and select the opacity of the audio meters.

5. Select Off to have the audio meter not visible for that channel transport.
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Channel Transport Control
Each channel in the server has a dedicated channel transport in Rio Replay Explorer that is used to load, play, 
record, and seek within clips. Clips are loaded into the channel transport from the Clip Library.

This chapter discusses the following topics:

• Using Channel Transports
• Loading Clips
• Trimming Clips
• Playing Clips
• Unloading Clips
• Using Clip Repeat Modes
• Recording Clips
• Locking Channel Transport Control
• Using Keyboard Shortcuts
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Using Channel Transports
Channel transports are grouped into sets of four (4). Switch between groups by clicking the other tab at the top of 
the channel transport controls. The name shown on the tab is the computer name for the server the channels are on. 
By default this is the serial number of the server.

 NOTE:
When video channels are configured as ISO or 3D, the Video Windows for all channels included in the ISO or 
3D are displayed in the master channel transport. Channel A will be the leftmost video window with the 
remaining channels in order.

Figure 7.1  Channel Transport Controls

1. Active Channel — The channel transport that is currently selected. Keyboard commands and clip selections 
are applied to this channel.

2. Video Window — Shows the full-motion video output of the channel. This can be the clip that is currently 
playing or the live video input to the channel when EE is on.

3.  Load Clip — Load the selected clip in the Clip Library into this channel. Press and hold the Shift key 
while pressing this button to eject the clip.

4. Clip Name — The name of the clip currently loaded into the channel transport.

5. Activity Indicator — Shows the current activity of the channel transport. It shows RECORDING when the 
channel transport is actively recording, IMPORTING when the channel transport is actively importing, and 
EXPORTING when the channel transport is actively exporting.

6.  Step Backward — Jog backward by one frame/field in the active clip.

7.  Step Forward — Jog forward by one frame/field in the active clip.

8.  Rewind — Rewind the current clip at 30-times normal speed.

9.  Play Reverse — Play the current clip in reverse at 1-times normal speed.

10.  Stop — Stop playback or recording on the current channel transport.

11.  Record — Open the Record Setup dialog to assist in recording a clip.

12.  Play — Play the current clip forward at 1-times normal speed.

13.  Fast Forward — Fast-Forward the current clip at 30-times normal speed.

14. Count-Down Timer — Shows the time remaining in the current clip. When the clip reaches the end the timer 
will show 00.00.00.00.

15. Timecode — Shows the timecode value of the current position in the clip. An f1 or f2 at the end of the 
timecode indicates Field playback (interlaced), and an f1-2 indicates Frame playback (progressive).

Double-click the timecode to enter a new timecode value manually. The channel transport immediately seeks to 
that timecode in the clip once you press Enter.
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16.  EE — Turn EE (Electronic to Electronic) mode On/Off for the selected channel transport. Also called 
bypass mode, where the video signal coming into the video channel is routed directly to the output without 
being stored and read from disk.

17.  Go to Start — Seek to the first frame of the clip.

18.  Play Normal — Normal play mode where the clip plays to the end and stops. Only one play repeat mode 
can be active at one time.

19.  Play Ping-Pong — Ping-pong repeat mode where the clip plays back and forth between the in and out 
points stored in the clip.

20.  Play Loop — Loop repeat mode where the clip starts playing again from the in point after it reaches the 
out point.

If the channel transport is being controlled externally using the Odetics protocol, this button is disabled.

21.  3-Point Loop — 3-Point Loop mode (also known as Multipoint repeat mode) where the clip can start 
playing from a point before the in point but starts playing again from the in point when it reaches the out point. 
The clip will continue to loop between the in point and out point from then on.

Clicking Play Repeat Normal allows the clip to ignore the out point and play through to the end frame of the 
clip. This does not interrupt the loop play in progress.

22. Play Speed — Shows the current play speed of the clip.

Double-click the play speed to enter a new play speed manually as a percentage. The clip will start playing at 
the new speed once you press Enter.

23. Clip Position Slider Handle — Indicates the current point in the clip that is being played. You can drag the 
handle back and forth to select a different point in the clip. Playback stops if you move the slider handle.

24. Clip Position Slider Bar — A graphical representation of the current clip. When the clip is playing or 
recording, the slider handle moves along the slider bar showing real-time progress through the clip. The slider 
handle and bar are green when playing and red when recording.

25.  Go to End — Seek to the last frame of the clip.

26.  Chain — Selects whether a channel transport is ganged with other channel transports. When Chain is 
turned on for a channel transport, that channel transport becomes linked to the other channel transports in the 
chain in Rio Replay Explorer. Within Rio Replay Explorer, any transport commands run on one channel 
transport in the chain are frame-accurately duplicated on all the other channel transports in the same chain. 
Commands sent to a channel transport from an external device over serial/ethernet control are not chained to 
the other channels.

 NOTE:
Record and Load/Eject Clip are not supported as chained commands and will only be performed on the channel 
transport that you run them on.
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Loading Clips
The clip can start to play as soon as it is loaded into a channel transport. Ensure that you are using the right channel 
configuration for the clip you want to load.

To Load a Clip

1. Select the channel transport you want to load a clip into.

 NOTE: 
If you are loading a VK (video + alpha) clip, ensure that the channel transport has been configured as VK as well.

2. Double-click the clip you want to load into the transport control. The clip must be in the same video format that 
the server is operating in. Alternatively, you can drag and drop the clip onto the channel transport area, or click 

the  Load Clip button next to the clip name in the transport control area.

The clip is loaded into the channel transport and the transport control buttons become active. The first frame of 
the clip is shown in the preview window in the transport control area. If you are using a remote Rio Replay 
Explorer client, the preview window is not available.

 NOTE:
If the Auto Play feature is enabled (Channel Transport > Enable Auto Play), the clip will start to play as soon 
as it is loaded.

Trimming Clips
You can trim the head (beginning) and tail (ending) off of a clip to shorten it and change the frame the clip starts and 
ends on. Trimming a clip is not destructive and the entire clip can be restored at any time. You can also edit the trim 
information from the metadata of the clip.

If you know the timecode values for the head and tail trim points, you can set them directly in the metadata of the 
clip.

To Trim a Clip

1. Load the clip you want to edit into a channel transport.

2. Seek through the clip to the point where you want the clip to start. This will be the new starting field/frame of 
the clip.

3. Click Channel Transport > Trim > Trim Head Off.

The portion of the clip before the trim point is hidden and the clip has been shortened.

4. Seek through the clip to the point where you want the clip to end. This will be the new last field/frame of the 
clip.

5. Click Channel Transport > Trim > Trim Tail Off.

The portion of the clip after the trim point is hidden and the clip has been shortened.

The trim information is stored in the metadata of the clip and is used every time the clip is loaded.

 TIP:
You can restore the head or tail of the clip by clicking Channel Transport > Trim and selecting Restore Head 
or Restore Tail.
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Playing Clips
Clips can play automatically once loaded, loop, or play at faster or slower speeds.

 NOTE:
If the Auto Play feature is enabled (Channel Transport > Enable Auto Play), a clip will start to play as soon as 
it is loaded into a channel. This feature applies to all channels and cannot be turned on or off for a particular 
channel transport.

To Play a Clip

1. Load the clip or playlist you want to play into the channel transport you want to play it out on.

2. Click the  Play button.

 NOTE:
You can add Cue Points to a clip that allow you to quickly seek to different points in the clip. Seek to the point in 
the clip that you want to add a cue point to and click Channel Transport > Mark Cue Point. Press the Ctrl key 
and use the left or right arrow keys to seek to the cue points before or after the current point in the clip. You can 
press Ctrl+' to delete the selected cue point, or click Channel Transport > Clear All Cue Points to clear all of 
the cue points in the clip.

The clip starts to play on the selected channel transport. If the selected channel transport is configured as V+K 
(Video+Alpha) and the loaded clip contains an alpha track, both video and alpha tracks from the clip are loaded 
and played simultaneously.

Unloading Clips
Remove a clip from the current channel transport.

To Unload a Clip

1. Select the channel transport you want to eject a clip from.

2. Click Channel Transport > UnLoad.

You can also unload a clip by pressing and holding the Shift key and pressing F1.

The clip is unloaded from the channel transport and color bars are loaded into the preview window and video 
output of the selected channel.

Using Clip Repeat Modes
There are a number of ways to have a clip continuously loop when playing out. These modes can be set in the 
metadata of a clip so that the clip always loads in this mode. They can also be set manually from the channel 
transport controls, or they can be set remotely from an external device.

Only one play repeat mode can be active at a time.

Repeat modes use Play Repeat IN and Play Repeat OUT points to determine what video to repeat. The default 
values for these points are stored in the metadata of the clip.

Normal (Off)

 Play Normal is the normal play mode where the clip plays to the end and stops. This mode is automatically set 
if you are controlling the channel transport from an external device, such as a switcher.
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Loop

 Play Loop mode starts the clip playing again from the in point again after it reaches the out point. When the 
clip starts playing, it immediately seeks to the Play Repeat IN point and plays until it reaches the Play Repeat 
OUT point. When it reaches the Play Repeat OUT point, it seeks back to the Play Repeat IN point and plays 
again. The clip will continue to play like this until stopped.

Ping-Pong

 Play Ping-Pong mode plays the clip back and forth between the in and out points. When the clip starts playing, 
it immediately seeks to the Play Repeat IN point and plays until it reaches the Play Repeat OUT point. When it 
reaches the Play Repeat OUT point it starts playing in reverse until it reaches the Play Repeat IN point again. The 
clip will continue to play like this until stopped.

Loop to Play

 3-Point Loop mode is a multipoint repeat mode that can start playing a clip from a point before the in point but 
starts playing again from the in point when it reaches the out point. The clip starts playing from the beginning, 
passing through the Play Repeat IN point, and continues playing until it reaches the Play Repeat OUT point. 
When it reaches the Play Repeat OUT point, it seeks back to the Play Repeat IN point and plays again. The clip 
will continue to play like this until stopped.

The portion of the clip before the Play Repeat IN point is only played the first time. This can be used if the 
repeating portion of the clip has a lead-in at the beginning. The lead-out portion of the clip can be played by 

switching the clip to the  Play Normal mode after the last repeat has started. The clip will then play to the end.

Recording Clips
When recording a clip, you can record a new clip, append to the end of an existing clip, or overwrite an existing 
clip. Clips can be recorded to the root, or a sub-folder in the Clip Library.

 TIP:
If you want to quickly record a clip using the same settings as the last time you recorded, press and hold the Shift 

button and click the  Record button.

Recording New Clips
Use a channel transport to record the video signal coming into the server.

To Record a New Clip

1. Select the channel transport that you want to record a clip to. This is the channel for the BNC on the back of the 
server that the audio/video you want to record is coming in on. Not all channels will have an associated BNC 
input, depending on the model and configuration of your server.

2. Eject any clip that may already be loaded into the channel transport.

3. Click the  Record button.

The Clip Record Setup dialog box opens.
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4. In the Record Type area, select the type of recording you want to do.

• New Clip (Record After Arming) — Arms the channel transport for recording a new clip.

5. In the Record Tracks area, select which tracks you want to record.

 NOTE:
Audio is recorded depending on how the Audio Input Source is set in the Rio Replay Config application.

• Video — Record the video and any embedded audio coming into the Video In BNC, depending on the audio 
source.

• Audio — Record the digital audio coming into the AES ports or the embedded audio on the Video In BNC, 
depending on the audio source.

6. In the New Clip area, enter a name for the clip in the Clip Name field.

If you want to record the clip into a sub-folder on the media drive you must include the folder path with the 
new. For example, 1080p Clips\Downtown-Fire records the clip Downtown-Fire in the 
1080p Clips folder. The folder must already exist in the Clip Library to be able to record to it.

7. Enter an 8-character ID for the clip in the Clip ID field.

If you are controlling the server from an external device, the clip ID is used on the external device to load a 
clip. If you do not assign a clip ID, the first 8 characters of the clip name can be used.

8. Turn Auto Name on if you want to create a series of clips with the same name plus an identifier.

• Off — Overwrite any existing clip of the same name.
• Numeric Append — Add a numeric digit to the end of the new clip name and increment it by one with each 

new clip of the same name.
• Time of Day — Add the current date and time to the end of the clip name.
• LTC In — Add a timecode stamp from the embedded timecode in the video signal being recorded.

9. Select a Timecode source for the new clip.

• Striped — Use the internally generated timecode data. The starting point for the timecode is set in the 
Starting at field.

• External TC — Use the timecode data embedded in the video signal being recorded.

10. Click OK.
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The channel transport is now armed to record. The video window shows live video coming into the channel, 

the  EE button is on, and the  Record button is flashing.

11. Click the flashing  Record button when you are ready to record.

The server starts recording, the  EE button goes off, and name of the new clip is shown at the top of the 
channel transport area, and the RECORDING indicator appears.

12. Click the  Stop button to stop recording.

Overwriting or Appending a Clip
Add to the end of an existing clip, or overwrite the clip entirely.

To Overwrite or Append a Clip

1. Select the channel transport that you want to record a clip to. This is the channel for the BNC on the back of the 
server that the audio/video you want to record is coming in on. Not all channels will have an associated input 
BNC, depending on the model and configuration of your server.

2. Prepare the channel transport for the type of recording you want to do.

• Append — Load the clip that you want to append the new recording to.
• Overwrite — Load the clip that you want to overwrite and seek to the point in the clip that you want to start 

the new recording.

3. Click the  Record button.

The Clip Record Setup dialog box is shown.

4. In the Record Type area, select the type of recording you want to do.

• Append — Arms the channel transport to start recording at the end of the current clip.
• Overwrite — Arms the channel transport to start recording at the currently selected point in the exiting clip. 

Everything after this point in the clip will be overwritten.

5. In the Record Tracks area, select which tracks you want to record.
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 NOTE:
Audio is recorded depending on how the Audio Input Source is set in the Rio Replay Config application.

• Video — Record the video and any embedded audio coming into the Video In BNC, depending on the audio 
source.

• Key — Record the alpha signal coming into the associated Video In BNC.
• Audio — Record the embedded audio on the Video In BNC, depending on the audio source.

6. Click OK.

The channel transport is now armed to record. The video window shows live video coming into the channel, 

the  EE button is on, and the  Record button is flashing.

7. Click the flashing  Record button when you are ready to record.

The server starts recording, the  EE button goes off, and name of the new clip is shown at the top of the 
channel transport area, and the RECORDING indicator appears.

8. Click the  Stop button to stop recording.

Locking Channel Transport Control
You can lock any channel transport control in Rio Replay Explorer. This prevents users from accidentally loading or 
ejecting a clip, or using any of the transport controls. Chained/Ganged channels are not affected by the lock.

 NOTE:
Locking a channel transport does not prevent the external control of that channel.

To Lock/Unlock a Channel Transport

1. Press and hold the Ctrl key and click the channel transport that you want to lock/unlock.

A lock symbol is shown over the controls when the channel transport is locked.

2. Press and hold the Ctrl key and click the channel transport again to unlock it.

Using Keyboard Shortcuts
Keyboard shortcuts work on the currently selected video channel transport in the Rio Replay Explorer window.

Two or more video channel transports can be linked (Chained) together so that commands sent to one channel are 
also sent to the others. Not all keyboard shortcuts support Chain control.
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Table 7.1  Rio Replay Explorer Keyboard Shortcuts

Function Shortcut Description Chain
Full Screen F11 (Windows® shortcut) Sets the Rio Replay Explorer 

window to full screen mode, or back to windowed 
mode.

No

Change Application Alt+Tab (Windows® shortcut) Switch between Windows® 
applications.

No

Select Channel A Ctrl+1 1 A Selects channel A as the active channel transport. No

Select Channel B Ctrl+1 1 B Selects channel B as the active channel transport. No

Select Channel C Ctrl+1 1 C Selects channel C as the active channel transport. No

Select Channel D Ctrl+1 1 D Selects channel D as the active channel transport. No

Select Channel E Ctrl+1 1 E Selects channel E as the active channel transport. No

Select Channel F Ctrl+1 1 F Selects channel F as the active channel transport. No

Select Channel G Ctrl+1 1 G Selects channel G as the active channel transport. No

Select Channel H Ctrl+1 1 H Selects channel H as the active channel transport. No

Chain Channel 
Transport Control

Ctrl+1 C C Clear all Channels — Sets all channel chain 
controls to Off.

No

Ctrl+1 C Y Chain Current Channel — Turns channel chain 
control on for the selected channel transport.

No

Ctrl+1 C N Unchain Current Channel — Turns channel 
chain control off for the selected channel transport.

No

Ctrl+1 C T Toggle Chain Current Channel — Toggles the 
chain control on or off for the selected channel 
transport.

No

Stop/Play Spacebar Stop or Play on the selected channel transport. Yes

EE Ctrl+E Y EE On — Turns EE (Electronic to Electronic) 
mode on for the selected channel transport.
Also called bypass mode, where the video signal 
coming into the server is routed directly to the 
output without being stored and read from disk.

No

Ctrl+E N EE Off — Turns EE mode off for the selected 
channel transport. The video output comes from the 
disk.

No

Ctrl+E T EE Toggle — Toggles EE mode on or off for the 
selected channel transport.

No

Load F1 Load the highlighted clip in the Clip Library into 
the selected channel transport.

No

Unload Shift+F1 Unloads the clip from the selected channel 
transport and loads a color-bar test pattern.

No

Jog Reverse F3 Reverses the clip in the selected channel transport 
by one frame/field. Press and hold the button to 
play the clip in reverse at 33% speed.

Yes
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Jog Forward F4 Advances the clip in the selected channel transport 
forward by one frame/field. Press and hold the 
button to play the clip forward at 33% speed.

Yes

Rewind F6 Rewinds the clip in the selected channel transport. Yes

Play Reverse F7 Plays the clip in the selected channel transport in 
reverse.

Yes

Stop F8 Stops playing or recording the clip in the selected 
channel transport.

Yes

Play F9 Plays the clip in the selected channel transport. Yes

Fast Forward F10 Fast-forwards the clip in the selected channel 
transport.

Yes

Seek to Start of Clip Ctrl+F6 Seeks to the first frame of the clip in the selected 
channel transport and stops.

Yes

Seek to End of Clip Ctrl+F10 Seeks to the last frame of the clip in the selected 
channel transport and stops.

Yes

Cue Points Ctrl+' Marks a cue point in the selected channel transport, 
or removes the current cue point.

No

Ctrl+Left Seeks backward to the next cue point in the 
selected channel transport.

No

Ctrl+Right Seeks forward to the next cue point in the selected 
channel transport.

No

Table 7.1  Rio Replay Explorer Keyboard Shortcuts

Function Shortcut Description Chain
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Variable Play F12 1× Forward — Plays the clip in the selected 
channel transport forward at 1 times speed.

Yes

F13 3× Forward — Plays the clip in the selected 
channel transport forward at 3 times speed.

Yes

F14 4× Forward — Plays the clip in the selected 
channel transport forward at 4 times speed.

Yes

F15 8× Forward — Plays the clip in the selected 
channel transport forward at 8 times speed.

Yes

F16 16× Forward — Plays the clip in the selected 
channel transport forward at 16 times speed.

Yes

F17 30× Forward — Plays the clip in the selected 
channel transport forward at 30 times speed.

Yes

F18 0.33× Forward — Plays the clip in the selected 
channel transport forward at 33% of 1 times speed.

Yes

Ctrl+F11 0.33× Reverse — Plays the clip in the selected 
channel transport backwards at 33% of 1 times 
speed.

Yes

Ctrl+F12 1× Reverse — Plays the clip in the selected 
channel transport backwards at 1 times speed.

Yes

Ctrl+F13 3× Reverse — Plays the clip in the selected 
channel transport backwards at 3 times speed.

Yes

Ctrl+F14 4× Reverse — Plays the clip in the selected 
channel transport backwards at 4 times speed.

Yes

Ctrl+F15 8× Reverse — Plays the clip in the selected 
channel transport backwards at 8 times speed.

Yes

Ctrl+F16 16× Reverse — Plays the clip in the selected 
channel transport backwards at 16 times speed.

Yes

Ctrl+F17 30× Reverse — Plays the clip in the selected 
channel transport backwards at 30 times speed.

Yes

Trim Ctrl+T H Head — Trims the head from the clip in the 
selected channel transport.

No

Ctrl+T T Tail — Trims the tail from the clip in the selected 
channel transport.

No

Gang All Ctrl+G P Gang Play — Plays all clips loaded in all channel 
transports.

Yes

Ctrl+G S Gang Stop — Stops all clips loaded in all channel 
transports.

Yes

Ctrl+G R Gang Re-cue — Re-cues all clips loaded in all 
channel transports.

Yes

Table 7.1  Rio Replay Explorer Keyboard Shortcuts

Function Shortcut Description Chain
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Record Ctrl+2 N New Clip Record — Creates a new clip in the Clip 
Library, loads it into the selected channel transport, 
selects LIVE EE mode, and starts recording to that 
clip.

No

Ctrl+2 C Create and Load New Clip — Creates a new clip 
in the selected channel transport with a 1-frame 
duration and parks on the first frame. It does not 
start recording.

No

Ctrl+2 A Append Record — Seeks to the end of the clip 
loaded in the selected channel transport, selects 
LIVE EE mode, and starts recording to that clip. A 
clip must be loaded into the selected channel 
transport before running this command.

No

Ctrl+2 O Overwrite Record — Selects LIVE EE mode and 
starts recording over the clip loaded in the selected 
channel transport. The server starts recording over 
the current clip at the location the selected channel 
transport is parked.

No

List Play Ctrl+L A Move Cursor to On-Air Item — Selects the item 
that is currently airing on the on-air playlist.

No

Ctrl+L B Move Cursor to Next On-Air Item — Selects the 
preview item on the on-air playlist.

No

Ctrl+L 1 to L 9 Move Cursor to On-Air Item X — Selects item X 
(1 to 9) on the on-air playlist.

No

Ctrl+L L Y List Play Loop Mode ON — Turns looping on for 
the on-air playlist. The entire contents of the 
playlist is looped.

No

Ctrl+L L N List Play Loop Mode OFF — Turns looping off 
for the on-air playlist.

No

Enter Take — Takes the next item on the on-air playlist. 
The Enter button found with the numeric keypad 
of your keyboard does not work for this command.

No

Table 7.1  Rio Replay Explorer Keyboard Shortcuts

Function Shortcut Description Chain
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Clip Library
The Clip Library appears on the bottom half of the Rio Replay Explorer window and shows all the media file clips 
that are currently available to the server. These clips can be located on the internal media drive of the Rio Replay 
server or on the media drive of a separate Rio Replay server.

Figure 8.1  The Clip Library

This chapter discusses the following topics:

• Displaying Clips
• Searching for Clips
• Using Playlists
• Creating Folders
• Using Clip Library Columns
• Editing Clip Metadata
• Using Parent and Child Clips
• Deleting Clips
• Locking and Unlocking Clips
• Using Timecode Chase Lists



8–2 • Clip Library Rio Replay User Guide (v10.2.0)

Displaying Clips
You can change the width and position of each column in the list, as well as sort the list based on the information in 
any column. You can select which columns are shown by navigating to the top of the Clip Library and selecting an 
option from Display Clips:

• Cueable Local — Only shows clips that are in the same video format that the server is operating in and are 
stored on the local media drive.

• All Local — Shows all clips that are stored on the local media drive. Clips that are not in the same video format 
that the server is operating in are displayed, but cannot be loaded.

• Remote — Only show clips that are located on a remote server. You can only load the clips from a remote server 
that is on the same network and operating in the same video format. Remote servers appear as folders in the Clip 
Library.

• Local & Remote — Shows all clips that are stored on the local media drive and on remote servers.

Searching for Clips
You can search the Clip Library for clip names that contain a specific word.

Enter the name of a clip you want to find in the search field located to the right of the Clip Library title bar. The 
Clip Library will only show those clips that match your search criteria and the number of clips shown is indicated in 
a yellow notification at the bottom of the screen.

Figure 8.2  Clip Library Search

Using Playlists
A playlist is a collection of clips that are sorted into the order you want them played. Playlists are created and edited 
within the Clip Library.

Creating and Editing Playlists
To Create and Edit a Playlist

1. If you are creating a new playlist, click New > New Playlist. The playlist will appear in the Clip Library as 
Untitled Playlist. Enter a name for the new playlist before proceeding. If you are editing an existing 
playlist, proceed to the next step.

2. Double-click the name of the playlist.

The Playlist Editor opens to the right of the Clip Library.
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3. Drag and drop clips from the Clip Library to the playlist.

 NOTE:
Right-click a clip and select Remove from list to remove the clip from the playlist.

4. Drag and drop clips within the playlist to order them how you want them to play out.

5. Set a different behavior for the start (@START) of a clip by right-clicking on the clip and selecting Set 
@START....

• Play — The clip plays out automatically when the playlist transitions to this clip in ON-AIR mode. This is 
the default setting.

• Pause — The clip is paused on the first frame when the playlist transitions to this clip in ON-AIR mode.

6. Set a different behaviour for the end (@END) of a clip by right-clicking on the clip and selecting Set @END....

• Take — The playlist transitions to the next clip in ON-AIR mode. This is the default setting.
• Pause — The clip is paused on the last frame when it reaches the end of the clip in ON-AIR mode. You must 

click TAKE to transition to the next clip.
You can press Enter on the keyboard to transition to the next clip, instead of clicking TAKE.

• Loop — The clip is looped when it reaches the end of the clip in ON-AIR mode. You must click TAKE to 
transition to the next clip.

7. Set a different transition length (TRANS) for the transition between the current clip and next by right-clicking 
on the clip and selecting Set Transition....
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 NOTE:
The dissolve transitions (MIX) require two channel transports (PGM/PVW) to be able to transition from one 
channel to the other (one clip to the other). The dissolve is applied between the two clips.

• CUT — A cut is performed between the clips.
• 0.05 MIX — A 5-frame dissolve is performed between clips.
• 0.10 MIX — A 10-frame dissolve is performed between clips.
• 0.15 MIX — A 15-frame dissolve is performed between clips.
• 0.20 MIX — A 20-frame dissolve is performed between clips.
• 1.00 MIX — A 1-second dissolve is performed between clips.

8. Click Save to save the changes to the playlist.

Click Save and AIR List to save the changes to the playlist and load it into the selected channel transport.

Taking a Playlist On-air
Take the playlist on-air to play each clip in order with the set transitions.

 TIP:
If you want to use mix transitions between the clips in the playlist, you must use two channel transports. 
Depending on the channel transport you select, the following channel transport is used for preview.

To Take a Playlist On-air

1. Double-click the playlist you want to air in the Clip Library.

2. Select the channel transport that you want to play the playlist on.

Select a channel (ChA, ChC, ChE, or ChG, ChI, ChK) if you want to use a mix transition. Channels B, D, F, 
etc. are used as the preview channels for ChA, ChC, CHE etc.

3. Click AIR List in the Playlist Editor window.

The Playlist Editor window changes to the PLAYLIST ON-AIR window. The first clip in the playlist is 
highlighted red and is loaded into the selected channel transport.

4. If you want to dissolve (mix) from one clip to the next in the playlist, select the transition channels (ChB > 
ChA, ChD > ChC, ChF > ChE, ChH > ChG, ChJ > ChI, ChL > ChK). If not selected, the playlist will cut 
from one clip to the next.

You are prompted whether you want to load the list in PGM/PVW mode. Click Yes. The next clip in the playlist 
(highlighted green) is loaded into the second (PVW) channel transport.

5. Click the  Play button to start playing the playlist.
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Click the  Play Loop to have the playlist start again at the beginning when it finishes the last clip. It is 
recommended that you set @START to PLAY and @END to TAKE to fully automate the loop.

The first clip starts to play out and execute the @Start, @End, and transition tags of the current clip. When the 
clip is close to the end (3 seconds) the next clip is highlighted, indicating that the PVW channel is about to go 
on-air as part of the transition.

 NOTE:
When you are finished using the playlist feature, click EXIT to take the playlist off-air and free up the channel 
transports for other uses.

Using Playlist Commands

As a playlist is playing out, you can skip items, cue up segments with manual or immediate playout, or re-cue to the 
start of the playlist. When you jump to a new location in the playlist, the server continues to play the clips from the 
new location.

To access the list of commands, right-click the clip you want to cue or play.

• Play this segment next — Play the selected clip after the currently playing clip finishes on the PGM channel. 
The clip is highlighted green and is played next.

• Cue this segment next — Cue the selected clip after the currently playing clip finishes on the PGM channel. The 
clip is highlighted green and is cued next. The clip pauses at the first frame and must be played manually.
You can manually play the clip by pressing the Spacebar on the keyboard.

• Play this segment immediately — Immediately load and play the selected clip on the PGM channel.
• Cue to this segment immediately — Immediately load and cue the selected clip on the PGM channel. The clip 

pauses at the first frame and must be played manually.
• Cue to start of playlist immediately — Immediately load and cue the first clip in the playlist on the PGM 

channel. The clip pauses at the first frame and must be played manually.

 TIP:
You can quickly take a different clip in the list by selecting the new clip and clicking the TAKE button or 
pressing Enter on the keyboard. 

Creating Folders
Clips are stored on the media drive in the server, or on external servers connected to the server you are using. You 
can organise the clips into folders on the media drive either from Windows® Explorer or from the Clip Library.

 IMPORTANT:
You cannot delete a folder from the Clip Library. You can only delete a folder from Windows®.
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To Create a Folder

1. Right-click an empty line in the Clip Library and click New Folder.

2. Enter a name for the new folder.

3. Drag and drop clips into the new folder.

Using Clip Library Columns
You can set the Clip Library to show or hide specific columns. Any column, with the exception of the clip name 
column, can be shown or hidden.

To Change Clip Library Columns

1. Click Clip Library > Select Columns....

2. Select which columns you want to show, or deselect the columns you want to hide.

3. Click OK.

Editing Clip Metadata
Clip metadata includes information like the name of the clip, the repeat mode, timecode source, and trim points. 
This information is stored with the clip and is copied to other servers with the clip.

 NOTE:
You cannot edit the metadata of a clip (Abekas® .CLIP) if it is locked. You must unlock the clip before you can 
edit the metadata.

Most metadata shown in the Clip Library can be edited directly by double-clicking on the cell in the table and either 
entering the new data or selecting it from a drop-down list.

Editing the Label Metadata of a Clip
The label metadata is shown in the Clip Library and is used to sort and identify clips.

To Edit the Label Metadata of a Clip

1. Select the clip in the Clip Library you want to edit the metadata for.

2. Click Clip Library > Modify....

3. Click the Labels tab.
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4. Edit the metadata item you want to change.

• Comments — A 255-character free form field.
• Project Name — A 255-character free form field.
• Creator — A 255-character free form field.
• Keywords — 6 independent 35-character searchable words. A keyword can only be a single word or 

conjunction without spaces.

5. Click OK.

Editing the Attribute Metadata of a Clip
The attribute metadata sets the default output mode for the clip, as well as the repeat function.

To Edit the Attribute Metadata of a Clip

1. Select the clip in the Clip Library you want to edit the metadata for.

 NOTE:
You cannot edit the metadata of a clip if it is locked.

2. Click Clip Library > Modify....

3. Click the Attributes tab.

4. In the Play Repeat area, select the repeat mode you want to use for the clip.

• OFF — Play repeat is turned off by default when the clip is loaded.
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• Loop — Play repeat loop is turned on by default when the clip is loaded. When the clip starts playing, it 
immediately seeks to the Play Repeat IN point and plays until it reaches the Play Repeat OUT point. When 
it reaches the Play Repeat OUT point it seeks back to the Play Repeat IN point and plays again.

• Ping Pong — Play repeat ping-pong is turned on by default when the clip is loaded. When the clip starts 
playing, it immediately seeks to the Play Repeat IN point and plays until it reaches the Play Repeat OUT 
point. When it reaches the Play Repeat OUT point it starts playing in reverse until it reaches the Play 
Repeat IN point again.

• Loop To — Play repeat loop to play is turned on by default when the clip is loaded. The clip starts playing 
from the beginning passing through the Play Repeat IN point and continues playing until it reaches the Play 
Repeat OUT point. When it reaches the Play Repeat OUT point it seeks back to the Play Repeat IN point 
and plays again.

• Ping Pong To — Play repeat ping pong is turned on by default when the clip is loaded. When the clip starts 
playing, it immediately seeks to the Play Repeat IN point and plays until it reaches the Play Repeat OUT 
point. When it reaches the Play Repeat OUT point it starts playing in reverse until it reaches the Play 
Repeat IN point again.

5. Use the Play Repeat IN and Play Repeat OUT fields to the set the timecode for the in and out points of the 
clip.

• Play Repeat IN — The first inclusive field/frame of the repeated portion of the clip. By default this is the 
first field/frame of the clip.

• Play Repeat OUT — The field/frame before the last field/frame of the repeated portion of the clip. By 
default this is one field/frame beyond the end of the clip.

6. In the Output Mode area, select the output video mode that you want to clip to play out in.

• Frame — Select this option if the clip was shot in a progressive video format.
• Field VI — Select this option if the clip was shot in an interlaced video format and you want to apply 

vertical interpolation (VI) to it. This mode is useful for clips that will be played out in slow motion or will be 
frequently paused. The VI helps to eliminate vertical hopping during slow motion playback and jagged 
edges in paused images.

• Field — Select this option if the clip was shot in an interlaced video format and you don't want to apply 
vertical interpolation (VI) to it.

 NOTE:
The server does not support video format conversion. If a clip is in a different video format than the server is 
operating in you will not be able to load it into a channel transport.

7. Click OK.

Editing the Timecode Metadata of a Clip
The timecode metadata sets the source of the timecode information for the clip.

To Edit the Timecode Metadata of a Clip

1. Select the clip in the Clip Library you want to edit the metadata for.

 NOTE:
You cannot edit the metadata of a clip if it is locked.

2. Click Clip Library > Modify....

3. Click the Timecode tab.
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4. In the TC Source area, select the timecode source.

• External TC - First Frame Only — The clip uses the external timecode data of the first field/frame that 
was originally recorded with the clip. The timecode for the remainder of the clip is synthesized. This option 
is useful if there was a break or interruption in timecode data during recording.

• External TC - Entire Clip Length — The clip uses the external timecode data that was originally recorded 
with the clip. This option is useful if the clip has different segments in it with different timecode ranges that 
you want to use.

• Striped — The clip uses the internally generated, or synthesised, timecode starting at a defined point. Enter 
the numeric timecode value that you want to use for the start of the clip.

5. In the Dropframe Flag area, select if you want to use Drop frame timecode or Nondrop frame timecode.

This option is only available if the clip was recorded in a 59.94Hz video format.

6. Click OK.

Editing the Trim Metadata of a Clip
The trim metadata allows you to trim the head or tail off of the clip, setting a new start and end point for the clip. 
You can also offset a specific track in the clip.

To Edit the Trim Metadata of a Clip

1. Select the clip in the Clip Library you want to edit the metadata for.

 NOTE: 
You cannot edit the metadata of a clip if it is locked.

2. Click Clip Library > Modify....

3. Click the Trim tab.
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4. In the Trim In field, enter the new starting timecode value for the clip. The Record Start field shows the 
timecode at the start of the clip.

5. In the Trim Out field, enter the new ending timecode value for the clip. The Recording End field shows the 
timecode at the end of the clip.

6. Use the Advance fields to slip the video, audio, or timecode track back in relation to the other tracks in the clip. 
Only those tracks that are present in the clip are shown.

Any content slipped past the start of the clip will not be present in the output of the clip.

Select Advance by an extra half-frame to slip that particular track back half of a field/frame.

• Advance Video Track — Slip the video track back in time relative to all the other tracks.
• Advance Audio Track — Slip the audio track back in time relative to all the other tracks.

7. Click OK.

Using Parent and Child Clips
You can create virtual copies of a clip. These child clips are pointers to the parent clip that use an independent set of 
metadata. This allows you to create a number of child clips that are trimmed differently from their parent and each 
other without taking up additional space on the media drive.

Once a child clip has been created, you cannot delete the parent clip until all the child clips have been deleted.

Creating a Child Clip
To Create a Child Clip

1. Right-click the clip that you want to create a child of.

2. Click Create Child Clip.

The child clip appears in the clip list with the same name as the parent clip, with - Child appended to the end 
of the clip name.

Deleting Clips
Permissions can be set for all three User types so they can delete individual clips, delete multiple clips at once, or 
not be able to delete any clips. For more information, see “Setting Account Permissions” on page 6–3.

 NOTE:
You cannot delete a clip if it is locked. Unlock the clip first, and then you can delete it.
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To Delete a Clip

1. Select the clip(s) that you want to delete.

2. Click Clip Library > Delete.

A prompt opens to confirm the deletion. Click Delete to delete the clip(s).

Locking and Unlocking Clips
Clips can only be locked or unlocked from Windows®. When a clip is locked, an orange lock icon is shown in the 
Locked column in the Clip Library.

To Lock or Unlock a Clip

1. Launch Windows® Explorer and navigate to the media drive on the server (Media Data (H):) and open the 
Video folder.

2. Locate the clip that you want to lock or unlock and right-click it.

To lock or unlock multiple files at once, select multiple files and right-click one of them.

3. Click Properties.

4. Click the General tab and select (locked) or un-select (unlocked) Read-only in the Attributes section.

5. Click OK.

Using Timecode Chase Lists
A Timecode Chase list (TC Chase List) allows you create a playlist where each clip in the list can be triggered by a 
timecode value. For each clip in the list, you set the timcode value that you want to clip to start playing. You also 
have the option of setting a new in point, or offset, for the clip if you don't want the clip to start playing from the 
beginning.

 NOTE:
You must have a valid timecode signal connected to the LINE IN port at the back of the server.

 TIP:
Because the TC Chase List does not use the LTC IN port, you can still use the time of day LTC input separate 
from a TC Chase List.
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Creating a TC Chase List
You can add clips to the TC Chase List in the same way you add clips to a playlist. Once the clips have been added, 
you can set the timecode value for when each clip will start playing, as well as any offset to the input of the clip that 
you want to jump to.

To Create a TC Chase List

1. If you are creating a new TC Chase List, click New > New TC Chase list and enter a name for the new TC 
Chase List. If you are editing a TC Chase List, proceed to the next step.

2. Double-click the name of the TC Chase List. The TC Chase Editor opens to the right of the Clip Library.

The current timecode coming into the server is shown at the top of the TC Chase List window.

3. Drag and drop clips from the Clip Library to the TC Chase List.

 NOTE:
Right-click a clip and click Remove from list to remove the clip from the TC Chase List.

4. Drag and drop clips within the TC Chase List to order them how you want them to appear visually. The order 
of the clips in the list does not change the playout order. Clips are played according to their TC Offset Trigger.

You can click Save at any time to save the current state of the TC Chase List.

5. Double-click the time in the TC Offset Trigger column for the clip you want to edit and enter the timecode 
value at which you want this clip to start playing. For example, if you want the clip to start playing at timecode 
01,00,30,00, enter 01,00,30,00.

6. If required, double-click the time in the Clip TC Offset column for the clip and enter the point in the clip at 
which you want it to start. This is an offset from the in point of the clip. For example, if you want the clip to 
start playing 5 seconds into the clip, enter 00,00,05,00.
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7. Repeat these steps for every clip in the TC Chase List.

8. Click Save.

Taking a TC Chase List On-air
 NOTE:

A TC Chase List has no mix transition and only uses a single channel transport.

To Take a TC Chase List On-air

1. Double-click the TC Chase List you want to air in the Clip Library.

2. Select the channel transport that you want to play the TC Chase List on.

3. Click START TC Chase on the TC Chase Editor window.

The TC Chase Editor window changes to the TC Chase ON-AIR window. As the timecode reaches the 
specified value for each clip, the clip is highlighted red and plays out on the channel transport. The channel 
transport outputs black if no clip is scheduled to play during the current timecode.
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Replay Overview
Rio Replay's advanced control interface and software suite are designed to meet the demands of live sports 
production. The system focuses on leveraging the existing skill set of replay operators while providing high-end 
tools and controls for pre-game playback, instant replays, highlight packaging, social media contributions, and 
post-production archiving.

This chapter discusses the following topics:

• Overview
• Using the Control Panel
• Using System Modes
• Examining the Replay Window
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Overview
The system includes a responsive Control Panel with tactile buttons, touchscreen LCD modules, and a customizable 
jog wheel and T-bar for precise navigation and editing. Users can personalize button layouts to match their 
workflow, while dynamic LCD screens update in real time to display the server status and available functions.

Figure 9.1  The Replay User Interface

Figure 9.2  The Replay Control Panel
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Using the Control Panel
The Control Panel has been designed to give you quick access to all the functions of the replay operation. The keys 
and controls found on the Control Panel are as follows:

Figure 9.3  Sections of the Control Panel

Table 9.1  Sections of the Control Panel

Number Name Description
1 System Buttons Used for different functionalities based on system status, either as a stand-alone button 

or in combination with other buttons.

2 Quickeys Touch operated buttons that allow faster access to certain functions.

3 Number Buttons Allows the operator to navigate Clips, Pages and Banks, as well as save and load clips. 
They can also be used enter numeric values in certain modes (for example, loading a 
clip by number).

4 Left Control Block A set of buttons and a corresponding LCD display that changes functionality based on 
system mode.

5 Right Control Block A set of buttons and a corresponding LCD display that changes functionality based on 
system mode.

6 Lower Control Block A set of buttons and a corresponding LCD display that changes functionality based on 
system mode.

7 Jog Wheel Browses media back and forth. Can also be used to navigate up and down different lists.

8 T-Bar Controls the playback speed. Can also be used as a selection option in some modes.
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Upper Control Block

Figure 9.4  The Upper Control Block

• 1, 2, 3, 4, 5, 6, 7, 8, 9, 0 — The function of each number button is shown on the Upper Control Block LCD 
display. The number buttons are used in different ways, depending on the Control Panel’s current mode of 
operation.

• MENU — Toggles between the clips list and the playlist.
• SHIFT — Allows the operator to access the shifted function for all the buttons on the Control Panel. By default, 

the main functions of the buttons will be illuminated brighter, while the shifted functions will be dimmed. When 
SHIFT is pressed, the shifted functions will be brighter while the default functions will be dimmed.

   
Figure 9.5  Default functions on the Lower Control Block (left) and shifted functions (right)
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When you press a button, or press the SHIFT button again, the Control Panel returns to normal.
• CLEAR — Clears or deletes text entries, clips, or playlists, depending on the system state. Press CLEAR and 

the number button matching the clip number to delete that clip.
• ENTER — Confirms user selections and adds loaded clips into the active playlist.

T-Bar

Figure 9.6  The T-Bar

• T-Bar — Allows the user to manually set the play speed of the clip playing out on the program channel.
By default, the range is from 0% play-speed at the bottom and 100% play-speed at the top. The T-bar has a 
secondary range that can be specified by the user, ranging from -9,900% to 9,900%.
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Using the Jog Wheel

Figure 9.7  Jog Wheel

• Jog Wheel — Allows the user to navigate through the clip loaded on the selected output. Turning the jog wheel 
clockwise moves forward. while turning it counter-clockwise moves backward. It can also be used to browse 
lists.

Using System Modes
There are four main system modes and several other operational modes. In each mode, the Control Panel buttons 
will change their functionality and the LCD screen will dynamically change to reflect the functionality of each 
button.

Main Operational Modes
• Live and Replay
• Clips
• Playlist Editing
• Playlist Playout

Other Operational Modes
• Playlist Management
• Import
• Marks and Vue Marks
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Live and Replay

Using the Upper Control Block - Live and Replay
• 1, 2, 3, 4, 5, 6, 7, 8, 9, 0 — Save or load clips, or switch pages and banks.
• MENU — Toggles between the clips list and the playlist.
• SHIFT — Allows the operator to access the shifted function for all the buttons on the Control Panel.
• CLEAR — Deletes clips. Press CLEAR and the number button matching the clip number to delete that clip.
• ENTER — Confirms popup confirmation screens.

To open settings

Press SHIFT + MENU to open the user settings.

Press MENU + ENTER to open the panel settings.

Using the Left Control Block - Live and Replay

Unshifted functions

• PGM1 — Selects the first Playout Channel.
• PGM2 — Selects the second Playout Channel.
• PGM3 — Selects the third Playout Channel.
• PGM4 — Selects the fourth Playout Channel.

 NOTE:
The numbered PGM buttons will only be shown for output channels that are assigned to the panel in the Rio 
Replay Config application.

• Gang — Ties PGM1 and PGM2 to run in sync.
• Save Clip — Create a new clip in the next available slot.
• Import — Switches the system to Import mode.

Shifted functions

• Load Clip — Depending on the previous action, load the last clip that was saved or the last clip that was loaded.
• PGM+PVW — Switch the Control Panel from MultiPGM to PGM/PVW mode.
• Reset Cam — Set controlled outputs to switch back to their default cameras. The default camera for each output 

can be set in the user settings.

Using the Right Control Block - Live and Replay

Unshifted functions

• Play — Plays the video loaded on the controlled outputs.
• < Cue — Loads the last created mark point (latest TC) and jumps up to earlier marks.
• Cue > — Loads the first created mark point (earliest TC) and jumps down to earlier marks.

 NOTE:
Cues are cyclic, so jumping up from the first cue will navigate back to the last cue.

• Mark — Sets a cue point on the incoming live timecode that can be recalled when required.
• Live-EE — Returns to the live input on the controlled output.

Shifted functions

• Recall — Load a clip by typing the clip number.
• Fast Jog — Allows the operator to jog through the clip at a faster speed using the Jog Wheel. The speed is set 

from the User Setup menu.
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• Page — Enables a selection of the different clips pages.

Using the Lower Control Block - Live and Replay

Unshifted functions

• PLST — Loads the active playlist.
Press PLST once to load the playlist in Edit mode.
Press PLST a second time to load the playlist in Playlist mode, from the selected item.
Press PLST a third time to cue the first item in the playlist.

• Browse — Loads the selected clip in the clips bank and allows the operator to use < Clip and Clip > in the Right 
Control Block to browse.

• IN — Sets a new IN point for the clip at the current timecode of the controlled output.
• OUT — Sets a new OUT point for the clip at the current timecode of the controlled output.
• TAKE — Opens and closes the camera selection menu on the Left Control Block.

Shifted functions

• Goto IN — Navigates to the selected IN point of the clip.
• Goto OUT — Navigates to the selected OUT point of the clip.
• 2nd T-Bar — Switches to a secondary T-bar range. The default secondary range is 0-2X (0 to 200%).

Clips

Using the Upper Control Block - Clips
• 1, 2, 3, 4, 5, 6, 7, 8, 9, 0 — Loads clips or switches pages and banks. Once a clip is loaded, pressing the button 

again will cue the clip to its IN point.
• MENU — Toggles between the clips list and the playlist.
• SHIFT — Allows the operator to access the shifted function for all the buttons on the Control Panel.
• CLEAR — Deletes clips. Press CLEAR and the number button matching the clip number to delete that clip.
• ENTER — Adds the loaded clip as the last item in the active playlist.

To open settings

Press SHIFT + MENU to open the user settings.

Press MENU + ENTER to open the panel settings.

Using the Left Control Block - Clips

Unshifted functions

• PGM1 — Selects the first Playout Channel.
• PGM2 — Selects the second Playout Channel.
• PGM3 — Selects the third Playout Channel.
• PGM4 — Selects the fourth Playout Channel.

 NOTE:
The numbered PGM buttons will only be shown for output channels that are assigned to the panel in the Rio 
Replay Config application.

• Save Clip — Saves a new clip into the next available slot. The Export Cam and Append buttons become 
available after pressing Save Clip.

• Import — Opens the Clip Library
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Shifted functions

• Load Clip — Loads the selected clip from the Clip Registers into the selected Playout Channel.
• PGM+PVW — Switches the playout channels to PGM+PVW mode. Pressing MultiPGM afterwards returns 

both playout channels to PGM mode.
• Reset Cam — Resets the selected Playout Channel to the start of the clip.

Using the Right Control Block - Clips

Unshifted functions

• Play — Plays the clip loaded on the controlled output.
• Mark — Sets a cue point on the incoming live timecode that can be recalled when required.
• Live-EE — Returns to the live input on the controlled output.
• < Clip — Loads the next clip on the controlled output.
• Clip > — Loads the previous clip on the controlled output.

Shifted functions

• Recall — Load a clip by typing the clip number.
• Fast Jog — Allows the operator to jog through the clip at a faster speed using the Jog Wheel. The speed is set 

from the User Setup menu.
• Return — Exits clip mode without changing the current timecode position.
• Page — Enables a selection of the different clips pages.

Using the Lower Control Block - Clips

Unshifted functions

• PLST — Loads the active playlist.
Press PLST once to load the playlist in Edit mode.
Press PLST a second time to load the playlist in Playlist mode, from the selected item.
Press PLST a third time to cue the first item in the playlist.

• Browse — Opens the Clip Registers and allows the operator to use the Jog Wheel to browse up and down. The 
first frame of each clip is loaded.

• IN — Sets a new IN point for the clip loaded on the controlled output.
• OUT — Sets a new OUT point for the clip loaded on the controlled output.
• TAKE — Opens camera selection options on the Left Control Block.

Shifted functions

• Loop — Sets the clip play mode to loop. Loop mode will be enabled until the user presses Live, loads a playlist, 
or presses SHIFT + Loop to turn off loop mode.

• Goto IN — Navigates to the IN point of the clip.
• Goto OUT — Navigates to the OUT point of the clip.
• 2nd T-Bar — Switches to a secondary T-bar range. The default secondary range is 0-2X (0 to 200%).

Playlist Editing
To load the active playlist for editing

1. With a playlist active, press the PLST button.

The playlist loads on the active output, and the Control Panel’s dynamic labeling shows Playlist Editing 
options.
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Using the Upper Control Block - Playlist Editing
• 1, 2, 3, 4, 5, 6, 7, 8, 9, 0 — Loads clips or switches pages and banks. Once a clip is loaded, pressing the button 

again will cue the clip to its IN point.
• MENU — Toggles between the clips list and the playlist.
• SHIFT — Allows the operator to access the shifted function for all the buttons on the Control Panel.
• CLEAR — Deletes clips. Press CLEAR and the number button matching the clip number to delete that clip.
• ENTER — Confirms popup confirmation screens.

To open settings

Press SHIFT + MENU to open the user settings.

Press MENU + ENTER to open the panel settings.

Using the Left Control Block - Playlist Editing

Unshifted functions

• Append — Adds the highlighted clip angle at the end of the playlist.
• Aux Audio — Turns auxiliary audio on or off.
• Insert — Adds the highlighted clip angle before the current playlist item.
• Speed — Enables the user to change the selected item’s playback speed. Speed can be pressed again to disable 

the function.
To edit more items, Press < Item or Item > to navigate through the list and adjust their speed with the T-bar. 
Once completed, press Speed again.

 NOTE:
The adjusted speed of a playlist item will only take effect when playing from the Play button. T-bar playback will 
overrule the item’s predefined speed.

• Effect — Changes the type of effect at the end of the item. Select Mix or Cut. To edit more items, Press < Item 
or Item > to navigate through the list and change the effect applied to them. Once completed, press Effect again.

• FX Dur — Changes the duration of the Mix effect. The T-bar can be used to adjust the effect duration, ranging 
from 0 to 2 seconds. < Item and Item > can be pressed to edit the playback speed of other items.

 NOTE:
When using Speed, Effect, or FX Dur, you can multi select or press the CTRL+A keys on the keyboard to apply 
the changes to multiple items at once.

• Delete — Deletes the selected item from the playlist.

Shifted functions

• Export PL — Exports the playlist.

Using the Right Control Block - Playlist Editing

Unshifted functions

• Play — Plays the clip loaded on the controlled output.
• < Item — Navigates to the previous item in the playlist.
• Item > — Navigates to the next item in the playlist.
• Mark — Sets a cue point on the incoming live timecode that can be recalled when required.
• Live-EE — Returns to the live input on the controlled output.

Shifted functions

• Recall — Load a clip by typing the clip number.
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• Fast Jog — Allows the operator to jog through the clip at a faster speed using the Jog Wheel. The speed is set 
from the User Setup menu.

• Return — Exits clip mode without changing the current timecode position.

Using the Lower Control Block - Playlist Editing

Unshifted functions

• PLST — Loads the active playlist.
Press PLST once to load the playlist in Edit mode.
Press PLST a second time to load the playlist in Playlist mode, from the selected item.
Press PLST a third time to cue the first item in the playlist.

• Browse — Allows the operator to use the Jog Wheel to browse up and down the playlist. The first frame of each 
clip is loaded.

• IN — Sets a new IN point for the clip loaded on the controlled output.
• OUT — Sets a new OUT point for the clip loaded on the controlled output.
• TAKE — Opens camera selection options on the Left Control Block.

Shifted functions

• Loop — Sets the clip play mode to loop. Loop mode will be enabled until the user presses Live, loads a playlist, 
or presses SHIFT + Loop to turn off loop mode.

• Insert — Adds the clip to the playlist that is being edited, before the current item.
• Goto IN — Navigates to the IN point of the clip.
• Goto OUT — Navigates to the OUT point of the clip.
• 2nd T-Bar — Switches to a secondary T-bar range. The default secondary range is 0-2X (0 to 200%).

Playlist Playout

Using the Upper Control Block - Playlist Playout
• 1, 2, 3, 4, 5, 6, 7, 8, 9, 0 — Disabled while in playlist playout mode.
• MENU — Toggles between the clips list and the playlist.
• SHIFT — Allows the operator to access the shifted function for all the buttons on the Control Panel.
• CLEAR — Disabled while in playlist playout mode.
• ENTER — Disabled while in playlist playout mode.

To open settings

Press SHIFT + MENU to open the user settings.

Press MENU + ENTER to open the panel settings.

Using the Left Control Block - Playlist Playout

Unshifted functions

• Next — Instantly plays the next clip in the playlist.
• Skip — Plays the current clip to the end, bypass the next clip, and continue with the clip after that in the playlist.
• Edit — Exits playlist playout mode and returns to playlist editing mode.

Using the Right Control Block - Playlist Playout

Unshifted functions

• Play — Plays the loaded playlist from its current position.
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• Cursor Up — Moves the playlist cursor up. The selected item will play next, once the currently playing item is 
finished.

• Cursor Down — Moves the playlist cursor down. The selected item will play next, once the currently playing 
item is finished. 

 NOTE:
Cursor Down has the same functionality as Skip.

• Mark — Sets a cue point on the incoming live timecode that can be recalled when required.
• Live-EE — Exits Playlist Playout mode and returns to the live input on the active output.

Using the Lower Control Block - Playlist Playout

Unshifted functions

• PLST — Plays the first item in the playlist.

Shifted functions

• Loop — Sets the clip play mode to loop. Loop mode will be enabled until the user loads a playlist.
• 2nd T-Bar — Switches to a secondary T-bar range. The default secondary range is 0-2X (0 to 200%).

Playlist Management
Playlists are a key feature for managing and sequencing clips. They enable operators to build structured packages 
for broadcast or review. The Rio Replay software suite enables the user to build up to 99 playlist per replay event, 
and each playlist can hold up to 999 clips.

To access existing playlists or create new ones, press Active PL from the programmable buttons.

Switching to Playlist Management Mode

After pressing Active PL in the Upper Control Block, the Playlist Library opens.

Figure 9.8  The Playlist Library

Using the Left Control Block - Playlist Management

Unshifted functions

• New PL — Adds a new playlist to the Playlist Library.
• Load PL — Loads the selected playlist to the active output.
• Rename PL — Enter a new name in the entry box, then press Rename PL or the Enter key on the keyboard to 

rename the playlist.
• Duplicate — Duplicates the selected playlist to the next available playlist number, including the name and all 

items.
• Delete PL — Deletes the selected playlist.
• Ins to Act — Adds all the selected playlist items before the last selected item of the active playlist.
• App to Act — Adds all the selected playlist items at the end of the active playlist.
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Using the Right Control Block - Playlist Management

Unshifted functions

• < PL — Navigates to the previous item in the playlist.
• PL > — Navigates to the next item in the playlist.
• Mark — Sets a cue point on the incoming live timecode that can be recalled when required.
• Live-EE — Returns to the live input on the controlled output.

Import
The operator can import clips that are already available on the server into the Pages and Banks of a replay event.

To Import a Clip from the Clip Library

1. Press Live.

2. Press Import.

3. The Clip Library opens.

4. To navigate through the Clip Library, the operator can either:

• Press the < Clip and Clip > buttons.
• Press the Browse button and use the Jog Wheel to navigate up and down the list.

5. The following actions can be performed in the Clip Library:

• Press Page 0 to import the clip into Page 0.
• Press P.X B.X (e.g., P.1 B.1) to import the clip into the active Bank.
• Press Aux Audio to add the clip as auxiliary audio to the active playlist.
• Press Append to add the clip to the end of the active playlist as an item.
• Press Insert to add the clip to the active playlist before the current item.
• Press Preview to preview the clip on the selected output.

6. Once finished, press Import or Live-EE.

Marks and Vue Marks

Marks

You can quickly create a mark point of the active camera to mark an event that you can come back to later. Creating 
the mark point automatically sets the mark point at that point in time and also sets an in-point and out-point based 
on the Auto-Mark IN/OUT setting of the User Setup.

You can create up to 999 mark points in a replay event.

Vue Marks

Unshifted functions

• Save Clip — Creates a new clip in the next available slot, using the default In and Out points set in the user 
settings.

• < Cue — Navigates to the previous item on the Cue list, starting from the last item.
• Cue > — Navigates to the next item on the Cue list, starting from the first.
• Live-EE — Go back to Live-EE on the selected outputs.
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Examining the Replay Window
The Replay window allows you to quickly view all the playout channels and camera inputs for the server, as well as 
access Clip Registers, Playlists, and other menu items.

Figure 9.9  The Replay Window

Playout Channels

Figure 9.10  Playout Channel

The playout channels are shown below the camera inputs as the program outputs. The name that appears on each 
playout channel can be set from the user settings. You can select each playout channel using the PGM buttons on 
the Control Panel. Each playout channel has a custom color to help you identify it quickly. This color is applied to 
the entire border when a playout channel is selected, and in a thin line around the image when the playout channel 
isn't selected.

The playout mode, timecode, and playback speed are all shown as a text overlay on the box, but the visibility of 
each of these elements depends on the mode of the playout channel. The location and transparency of the audio 
meters is set from the Rio Replay Explorer Configuration, and is not visible in the image above.
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Camera Inputs

Figure 9.11  Camera Inputs

Above the playout channels are the camera inputs. This is the live feed that is coming in from each camera at the 
event. Each camera input can be selected by pressing the corresponding softkey in the Upper Control Block of the 
Control Panel.

The camera inputs are tallied with the color of the playout channel they are selected on. In the example above, 
CAMERA 2 is selected on the PGM-1 playout channel. The PGM-1 playout channel has been assigned the red 
color in the user settings, so the box around the CAMERA 2 camera input is also red.

Lists and Menu

Figure 9.12  Lists and Menus

Below the playout channels are the Clip Registers and the Playlist/Menu interface. When one region is active, the 
other region is dimmed. The amount of dimming is set in the user settings.
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Replay Events
A replay event puts the server into replay operation. The incoming video signals from the cameras are continuously 
being recorded for use in a replay. When an event you want to replay occurs, you can seek to the start of the action 
that you want to replay and play it out of one of the playout channels.

This chapter discusses the following topics:

• Creating and Editing Replay Events
• Opening a Replay Event on a Control Panel
• Creating and Editing a Replay Event Template
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Creating and Editing Replay Events
A replay event puts the server into replay mode and optimizes the interface for a replay.

 NOTE:
The server must be configured into the ISO mode you want to use for your replay setup, and any Control Panels 
must be connected to the server and assigned to playout channels before you can create a replay event.

If you have already created a replay event, you can right-click the file in the Clip Library and click Modify Replay 
Event.

To Create/Edit a Replay Event

1. In Rio Replay Explorer click  on the ISO record channels to confirm the input video from the cameras.

2. In the Clip Library, right-click and select New > New Replay Event.

The Create New Event window opens.

3. In the Replay Event Name field, enter a name for the replay event.

4. On the Record Channel list, select the channel transport that you want to use for the multi-channel ISO clip.

The ISO mode records multiple video streams into a single clip and uses a single channel transport. In most 
cases this will be channel A (ChA).

5. Click Next.

6. Do you have a User Setup file for your Control Panel that you would like to use?

• Yes – click Select Replay Control Surface User Setup, navigate to the file, and click Open.
• No – proceed to the next step

7. Click Next.

8. Do you have a Replay Event Template that you would like to use?

• Yes – click Select Replay Event Template, navigate to the file, and click Open.
• No – proceed to the next step.
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If any clips included in a playlist in the template have been moved or deleted, they will be listed as missing. 
Click Select Path to Locate Missing Clips, navigate to the new location for the clips and click Select Folder. 
If you want to save this new location for the clips select Save New Paths back to original Replay Event 
Template.

9. Click Next.

10. Do you have an XPression DataLinq server that you want to use to provide clip naming and tagging?

• Yes — click Add and enter the name (Name), IP address (Address), and port (Port) for the DataLinq server.
• No — proceed to the next step.

11. Click Next.

12. In the Camera Name field, enter a name for each camera feed.

13. On the Camera Number list, select the number you want to assign to each camera feed.

14. Click Next.

15. You can add Clip Naming Softkeys to be used in the replay event.
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16. You can add preset tags that can be applied to replay clips for each individual team, or both, using the softkeys. 
Set the tags you would like to use as follows:

a. Click the … next to the Team-1 or Team-2 to change the name of the team and the color. The box around 
the tags changes to the team color when the team name is selected.

b. Click the Team-1, Team-2, or Both to select which team you want to create a tag for.

c. In the SK 1 through SK 9 columns, enter a shifted (Shift + SK X) and unshifted (SK X) tag.

The shifted and unshifted tags allow you to be able to apply two different tags from the same softkey.

17. Click Next.

18. You can add preset tags that can be applied to replay clips for each individual team, or both, using the softkeys. 
Set the tags you would like to use as follows:

a. Click the … next to the Team-1 or Team-2 to change the name of the team and the color. The box around 
the tags changes to the team color when the team name is selected.

b. Click the Team-1, Team-2, or Both to select which team you want to create a tag for.

c. In the SK 1 through SK 9 columns, enter a shifted (Shift + SK X) and unshifted (SK X) tag.

The shifted and unshifted tags allow you to be able to apply two different tags from the same softkey.
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19. Click Next.

20. Click Create Event.

The replay event has been created in the Clip Library.

21. Click Start RECORDING.

The replay event is now recording in the channel transport.

22. Click Finish.

The recording channel shows it is recording the camera inputs.

With the event created and recording, you can now open the event on the Control Panel to launch the replay 
operation interface.

Opening a Replay Event on a Control Panel
Open a replay event on a Control Panel to activate the replay interface.

To Open a Replay Event on a Control Panel

1. In the Clip Library, right click the replay event you want to open and click Event > Open on Control Panel.

Rio Replay Explorer searches for and connects to the Control Panel. Upon successfully connecting, the Replay 
Event window opens.

Figure 10.1  Replay Event Window
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Creating and Editing a Replay Event Template
Replay event templates save camera names and numbers, clip naming preset softkeys, clip pointers, and clips that 
have been placed in the playlist for the replay event.

To Create/Edit a Replay Event Template

1. In the Clip Library, right-click the replay event that you want to save as a template. Select Event > Save as 
Replay Event Template.

2. In the Template Name field, enter a name for the template and click Next.

 TIP:
Select an already existing template to overwrite it with the new template settings.

3. Select the playlists that you want to include with the template.

Any server clips in the playlist that is included in the template are assigned to the same playlist in the new 
replay event created from the template. For example, clips of player headshots are on a playlist called Players 
that is included in template. When that template is applied to a replay event, the Players playlist with the clips 
appears in the event.

4. Click Create Template > Finish.
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Replay Operation
This chapter discusses the following topics:

• Loading Server Clips
• Using Playlists and Playlist Items
• Mouse Workflows
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Loading Server Clips
Loading clips into the replay event allows you to quickly add them to a playlist or use them during a live replay. 
You can load server clips into a replay event where they can be trimmed, edited, cued, and saved to any of the 
replay event clip banks.

To Import a Clip from the Clip Library

1. Select the playout channel that you want to load the clip into.

2. Press Live.

3. Press Import.

The Clip Library is shown at the bottom of the window.

Only clips that are local and in the same video format that the server is operating in (cueable) are shown on the 
list.

4. Select the clip that you want to use in the replay event. Use either navigate the list:

• Press the < Clip and Clip > buttons.
• Alternatively, press the Browse button and use the Jog Wheel to navigate up and down the list.

5. Perform one of the following actions:

• Press Page 0 to import the clip into Page 0.
• Press P.X B.X (e.g., P.1 B.1) to import the clip into the active Bank.
• Press Aux Audio to add it as Auxiliary Audio to the active Playlist.
• Press Append to add it to the end of the active Playlist as an item.
• Press Insert to add it to the active playlist before the current item.
• Press Preview to preview the item on the selected output.

6. Once done, press Import or Live-EE.

Using Playlists and Playlist Items
Playlists are a key feature for managing and sequencing clips. They enable operators to build structured packages 
for broadcast or review. Users can build up to 99 playlists per replay event, and each playlist can hold up to 999 
clips.

Creating and Loading Playlists
Replay clips can be collected together into a playlist to be be taken on-air.

To create and load playlists

1. In the Upper Control Block, press Active PL.

The Playlist Library opens.

Playlist menu options are shown on the Left and Right Control Block.



Rio Replay User Guide (v10.2.0) Replay Operation • 11–3

2. Press <PL and PL > to navigate through the Playlist Library. Alternatively, press the Up and Down arrow keys 
on the keyboard.

3. Use the following buttons on the Left Control Block to perform playlist actions:

• New PL — Adds a new playlist to the Playlist list.
• Load PL — Loads the selected playlist to the active output.
• Rename PL — After entering the name of the playlist in the box, press Rename PL. Alternatively, press the 

Enter key on the keyboard.
• Duplicate — Duplicates the selected playlist to the next available playlist number.
• Delete PL — Deletes the selected playlist. Requires confirmation.
• Ins to Act — Adds all selected playlist items before the last selected item of the active playlist.
• App to Act — Adds all the selected playlist items at the end of the active playlist.

Editing Playlists
To edit playlists

1. On the Control Block, press PLST.

The playlist loads on the active output.

2. Different options are shown on the Left Control Block:

• Append — Adds the selected clip angle at the end of the playlist.
• Aux Audio — Turns auxiliary audio on or off.
• Insert — Adds the selected clip angle before the current playlist item.
• Speed — Enables the ability to change the item’s playback speed. Once pressed, the button will blink and 

the T-bar can be used to set the playback speed. < Item and Item > can be pressed to edit the playback speed 
of other items. When Speed is pressed again, it disables the ability to change the item’s playback speed.

 NOTE:
The speed of a playlist item will only be applied when played using the Play button. Playback using the T-bar 
will overrule the item’s predefined speed.

• Effect — Changes the effect type at the end of the item.
• FX Dur — Changes the duration of the Mix effect. The T-bar can be used to adjust the effect duration, 

ranging from 0 to 2 seconds. < Item and Item > can be pressed to edit the playback speed of other items.

 NOTE:
When using Speed, Effect, or FX Dur, you can multi select or press the CTRL+A keys on the keyboard to apply 
the changes to multiple items at once.

• Delete — Deletes the selected item from the playlist.

Mouse Workflows
If a mouse is connected to the Rio Replay server chassis through one of the USB-A ports, it can be used to perform 
various actions while a replay event is open, either by clicking or dragging and dropping different elements.
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Using Context Menus with a Mouse
To use context menus with a mouse

1. In an open replay event, navigate to the Clip Registers or Playlist interface with the mouse.

2. Right-click a clip or playlist item.

The context menu opens.

   
Figure 11.1  The context menu in the Clip Registers (left) and Playlist (right)

3. In the context menu, various functions can be performed that would otherwise require the use of a Control 
Panel.

For example, after right-clicking a clip in the Clip Registers, it can be copied, cut, pasted, or exported by 
clicking the appropriate option.

Using a Mouse to Move Clips and Camera Angles
To move clips with a mouse

1. In an open replay event, navigate to the Clip Registers or Playlist/Menu interface with the mouse.

2. Click and hold a clip or playlist item, then move the mouse cursor to the desired location in the list.

3. Release the left mouse button to place the item.

For example, a clip can be dragged and dropped from the Clip Registers to the active playlist.

To rearrange camera angles with a mouse

1. In an open replay event, navigate to the PGM and Camera windows.

2. Click and hold one of the Camera windows, then move the mouse cursor over one of the PGM windows.

3. Release the left mouse button to swap the angles.

Using a Mouse to Load Clips
To load clips and playlists with a mouse

1. In an open replay event, navigate to the Clip Registers or Playlist/Menu interface with the mouse.

2. Double-click the clip or playlist item.

The clip or playlist is loaded into the active output.

Using a Mouse to Switch Between Modes in the Clip Registers
To switch between Clip and CAM Modes with a mouse

1. In an open replay event, navigate to the Clip Registers with the mouse.

2. Click the Clip or CAM button.
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Either Clip mode or CAM mode is enabled, depending on the selection.

To sort by Name or Tags with a mouse

1. In an open replay event, navigate to the Clip Registers with the mouse.

2. Click the Name or Tags button.

The list is sorted by Name or Tags, depending on the selection.
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Replay Logger
The Logger is a separate user interface. It is a tool for operators to perform multiple functions through rapid data 
entry, including applying keyword metadata to clips, searching for clips, and creating playlists. It is recommended 
that the Logger be opened on a different monitor than the Rio Replay Explorer application so that a different 
operator can use it.

This chapter discusses the following topics:

• Opening the web-based UI
• Setting up the Logger
• Using the Log Function
• Using the Search Function
• Enabling Dark or Light Mode



12–2 • Replay Logger Rio Replay User Guide (v10.2.0)

Opening the web-based UI
To open the web-based UI

1. In a supported web browser, enter the following URL:

http://localhost:8878/workbench
The empty UI opens in the browser tab.

Setting up the Logger
To open the Logger

1. In the browser tab, click Replay on the menu bar.

2. In the pop-up menu, select LOGGER.

The Logger tab opens.
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To create tags for the Logger

1. In the Replay Explorer application, right-click the desired replay event and select Event > Modify Replay 
Event.

2. In the Modify Replay Event window, make any desired changes until you reach the Modify Replay Event: 
Clip Tags page.

a. Click the … next to the Team-1 or Team-2 to change the name of the team and the color. The box around 
the tags changes to the team color when the team name is selected.

b. Click the Team-1, Team-2, or Both to select which team you want to create a tag for.

c. In the SK 1 through SK 9 columns, enter a shifted (Shift + SK X) and unshifted (SK X) tag.

The shifted and unshifted tags allow you to apply two different tags from the same softkey.

3. Continue through the Modify Replay Event window and close it when you are finished.

To create a remote connection from the same network

1. The Logger can be opened from a different device on the same network while a replay event is open. Enter the 
following URL in a supported browser on the device:

http://00.00.00.00:8878/workbench
When entering the URL, change the IP address from 00.00.00.00 to the IP address matching the server that 
is running the Rio Replay Explorer application.

 IMPORTANT:
A device can only have one instance of the Logger open at a time. If a new Logger tab is opened while another 
tab already exists, the new tab displays an error message.
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Using the Log Function
To tag clips

1. In the Rio Replay Explorer application, right-click the desired replay event and select Event > Open on 
Control Panel.

2. In the Logger, ensure that Log is selected on the lower menu bar. Refresh the window if the tags are not shown.

The tags are shown as buttons in the interface.

3. When a clip is loaded in the replay event, one of the created tags can be selected in the Logger to apply that tag 
to the clip. Selected tags are highlighted green.

4. To remove a tag from a clip, click it again. Alternatively, select the  symbol in the list on the right side of 
the screen.
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5. On the Rio Replay Control Panel, press Save Clip to save the applied tags.

After successfully tagging a clip, keywords are cleared and must be selected again to tag another clip.

To use sticky keywords

1. In the Rio Replay Explorer application, ensure the controlled output is in Live-EE or Playlist mode.

2. In the Logger, ensure that Log is selected on the lower menu bar.

3. Double-click a tag to use it as a sticky keyword.

 NOTE:
Sticky keywords are highlighted red instead of green.

4. Click a sticky keyword a third time to remove it from the clip. Alternatively, select the  symbol in the list 
on the right side of the screen.

5. On the Rio Replay Control Panel, press Save Clip to save the applied tags.

After successfully tagging a clip, sticky keywords remain selected and can be used to tag another clip.

Using the Search Function
To search for tagged clips

1. In the Logger, click REPLAY on the left-side menu bar.

2. In the pop-up menu, select LOGGER.
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3. In the lower menu bar, select Search.

4. Select the desired tags. Tags act as the Search Keywords, which appear on the right once selected. The number 
of found clips is displayed on the lower-right side of the screen.

To create a playlist using Search Keywords

1. Ensure that Search is selected on the lower menu bar.

2. With the desired Search Keywords selected, click the Create Playlist button at the bottom of the Search 
Keywords box on the right side of the Logger tab.

A playlist is created in the Rio Replay Explorer application using the tagged clips.

 NOTE:
As more keywords are selected during a Search, the number of Results found will decrease. The Search function 
only includes clips that have all the selected tags applied to them.

 IMPORTANT:
The number of found clips in the Logger may not accurately represent the amount of clips that will be added to a 
created playlist. The Results number includes every angle in the found clips, but clicking Create Playlist will 
only include the primary angle of each clip.
For example, if the Search finds 3 clips, each with 8 angles, the Search Results will show 24 clips but the created 
playlist will only include the 3 primary angle clips.

Enabling Dark or Light Mode
To enable dark or light mode

1. On the left-side menu, select the brightness icon.

   

Either dark or light mode are enabled, depending on the prior selection.

2. To return to the previous theme, select the brightness icon again.
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Export
You can export a clip from the Clip Library to a number of formats for use in an external device. Files are exported 
in the same video format that the server is operating in.

This chapter discusses the following topics:

• Supported Video and Audio Media Files
• Selecting an Export Destination
• Exporting Media Files
• Growing File Export
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Supported Video and Audio Media Files

 NOTE:
Other formats may be supported for export, but have not been tested for compatibility.

Selecting an Export Destination
You can set up to nine export destinations, each with a different export format. Destination folders should only be 
located on network drives or high-speed USB drives (USB 2.0/3.0/3.1) mounted on the server.

 IMPORTANT:

Do not select an export destination on the system (C:) or media drive (H:) of the server. These drives are reserved 
for the operating system and media playout and recording. Exporting to either of these drives could cause video 
errors and system instability.

To Select an Export Destination

1. In Rio Replay Explorer, click Configure > Export Configuration.

Table 13.1  Video and Audio Media Files for Export

Codec Export Transcoding
AVC-Intra MXF Op1a / Native .clip No – Native codec

ProRes 422 MXF Op1a / MOV Yes

ProRes 422 HQ MXF Op1a / MOV Yes

ProRes 422 LT MXF Op1a / MOV Yes

DNxHD 120/145/240/290 MXF Op1a / MOV Yes

XDCAM50 422 MXF Op1A Yes

XDCAM EX MXF Op1a / MOV Yes

MPEG-4 10Mb/s AVI AVI Yes
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2. Click the Destination X tab for the destination you want to set up or edit.

3. Select the Enable this destination check box to make the destination available for export. Destination 1 is 
always available for export.

4. In the Destination Name field, enter a new name for the destination tab.

5. Click Export Type and select the codec you want to use for the export.

 NOTE:
All 1080i export formats are also available in 1080p, excluding XDCAM50.

6. Click Change and select the network drive or USB folder that you want to export to.

7. Click Select Folder.

The selected folder is shown in the Export directory field.

8. Select the naming and melt option you want to use for the export.

• Media File Name Information — Select the information you want to include in the name for the exported 
clip. An example of what the name will look like is shown at the bottom of the box.

• Playlist Media File — Select whether the playlist is exported as a single or multiple files.
• Super Slow Motion Clips — Select how super slow motion (SSM) clips are exported:

› All Frames of Video (No Audio is SSM) — Clips are exported with all frames but audio is stripped.
› 1x Real Time Speed (With Audio / Skips Video Frames) - Progressive Formats Only — Clips are 

exported at normal speed with audio, but the extra frames for slow motion are stripped.
• Melt Options

› All Frames of Video (No Audio is SSM) — Clips are exported with all frames but audio is stripped.
› 1x Real Time Speed (With Audio / Skips Video Frames) - Progressive Formats Only — Clips are 

exported at normal speed with audio, but the extra frames for slow motion are stripped.

9. Select an additional export destination as required.

10. Click Verify Export Destinations to verify that all destinations can be found.

A message is shown next to the button stating that all destination are valid, or that destinations are missing. The 
destinations that are missing are highlighted in orange.

11. Click OK.

Exporting Media Files
You can export media files from the server to another format that can be used by another device.

 NOTE:
Some export functions require a channel to export video. Ensure that the channel you want to use for exporting is 
not being used before you start the export.

To Export Media Files

1. Launch the Rio Replay Explorer application.

2. Click Clip Library.

3. Select the clip(s) that you want to export in the Clip Library.

4. Click Clip Library > Export.

The Export Editor opens with the selected clips listed.
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 NOTE:
To export/melt the clips from the playlists in a replay event, right-click the replay event you want to export the 
playlist from and click Melt Replay Event. Select the playlist(s) you want to export and click Finish. The 
Export Editor opens with the clips from the selected playlist(s).

5. To select a different destination for a clip, right-click the clip and click Set Destination... and select the new 
destination.

6. To export a different camera angle from a replay event clip, right-click the clip and click Set angle... and select 
which camera you want to export, or select All Cams.

7. To set a custom in-point and out-point, load the clip into the selected channel transport and use the transport 
controls to locate the new in-point or out-point and click IN or OUT to set that point. The timecode for the new 
in-point and out-point is shown in the table.

To split the clip into segments, set the in-point to where you want the segment to end and click Split Segment. 
A new clip of the same name and export destination is created.

To duplicate the segment, set the in-point and end-point to where you want to new clip to start and end and 
click Duplicate Segments. A new clip of the same name and export destination is created.

8. Select all the clips you want to export and click Move to Export Queue.

The Export Queue opens with the selected clips listed.

9. Click Start Export.

10. If your export requires transcoding, in the Channel to take offline list, select the channel that you want to use 
for the export and click OK.

The server starts exporting the clips to the destination folders.

 NOTE:
Click Abort Export to stop the export. The current clip is put back into the Export Queue with the remaining 
clips.

Growing File Export
You can constantly export any channel that is being recorded, including one or more angles of a replay event, to an 
export location on network drives or network attached storage (NAS). The growing files can then be imported into 
a non-linear editor where they can be worked on in near real-time as the file continues to grow. There is some delay 
in the export process relative to the live record point.

The Growing File Export service in Windows® needs permissions to access the NAS for the export. Once this is set 
up you can direct the Growing File Export to that network storage location.

Setting NAS Permissions for Growing File Export
To Set NAS Permissions for Growing File Export

1. Launch the Services application from Windows®.

2. In the Services list, locate Abekas Growing File Export.

3. Right click Abekas Growing File Exporter and click Properties.
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4. Click the Log On tab.

5. Select This account and click Browse.

The Select User dialog opens.

6. Click Advanced.

A new Select User dialog opens.

7. Click Find Now.

A list of valid User Accounts is shown.

8. Select the user account of the NAS you want to use for the Growing File Export and click OK.

9. Verify that the user account is now listed in the Enter the object name to select field and click OK.

10. Enter the password for the selected user account in the Password and Confirm password fields and click OK.

11. Click OK on the Services popup.

12. Select the Abekas Growing File Exporter and click Restart the service.

Creating Growing Export Files
The growing export works in real-time to export clips or replay events as they are being recorded. There is a 
separate growing file export for each record channel transport on the server.

When exporting to a NAS, the Growing Export File service must have permissions to access the NAS and the NAS 
must be mapped to a network drive to be able to use the feature. Refer to Windows® documentation for information 
on mapping a network drive.

The configuration options that are available for export depend on the channel configuration of the server.

To Create Growing Export Files

1. Click Configure > Export Configuration > Growing File Export.

2. Select Enable for the record channel that you want to set up the growing export for.

The options available depend on how the server is configured and whether the hardware channel has been set 
up for single-channel or multi-channel IOS operation.
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3. Click Browse and select the network drive or USB folder that you want to export to.

4. Click Select Folder.

The selected folder is shown in the Path field and the Ch Status line shows IDLE in green.

5. Select From 1st frame to have the export start with the first frame of the recording.

6. In the Export Angles area, select which camera angles you want to include in the export.

7. In the MXF Filename Fields area, select how you want the export file to be named. An example of how the 
name will appear will be shown.

8. Select how you want to export different camera angles:

• Create one MXF file containing Multiple Angles 
• Create many MXF files; one for each Angle 

9. Click START Export to start the growing file export operation.

The growing file export starts about 40 seconds after the selected record channel starts recording. If the record 
channel is already recording, the growing file export starts about 40 seconds after you click START Export.

10. Click OK.
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Remote Control Support
Use the information in this chapter to assist you in setting up an external device to control your server.

This chapter discusses the following topics:

• Using Remote Communications (RS-422)
• Clip ID Support
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Using Remote Communications (RS-422)
Direct serial control of each channel transport on the server is available through the RJ45 ports on the breakout 
cable connected to the server. Ethernet communications can also be used to control a channel transport instead of 
the direct serial connection.

The first RJ45 port on the breakout cable provides control over channel transport A, the second port provides 
control over channel transport B, and so on.

 NOTE:
RJ45 to DB9 converters are provided in the installation kit if needed.

 NOTE:
The BVW-75 and Odetics protocols are not supported over ethernet at this time.

The procedure for setting up a room for external control depends on the protocol you want to use.

Configuring a Room for the BVW-75 Protocol
Set up a Room to use the BVW-75 protocol to control server channels.

 NOTE:
The BVW-75 protocol does not support clip library listing or clip loading.

To Configure a Room for the BVW-75 Protocol

1. Launch the Rio Replay Config application.

You may be prompted to allow the program to make changes on the computer, click Yes.

2. Click the Protocols tab.

3. Click Room X Configuration and select the room you want to configure. Later, you will assign this room to a 
channel.

4. In the RS422 Protocol area, select BVW-75.
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5. In the Response Time area, select how quickly the server executes the Clip Play command after the Clip Load 
command.

• Fast — Executes the play command immediately after the load command. This is recommended when 
controlling the server from an external switcher.

• Accurate — Executes the play command only after receiving confirmation that the clip has loaded. This is 
recommended when controlling the server from an automation system.

6. In the Edit Timing area, select a timing offset for when you are controlling the server from an external editor 
over serial.

• Timecode Alignment — Select the offset, in frames, of the timecode information that is sent to the editor 
during playout or record.

• Source Alignment — Select the offset, in frames, of the timecode information that is sent to the editor 
during playout.

• Out Point Offset — Select the offset, in fields, of the out-point timecode value that is sent to the editor 
during record.

7. In the Video Edit Effect area, select which tracks get recorded when an external editor issues the Video Record 
command to the server.

• Edit Video Track — Only the video track is recorded.
• Edit Key Track — Only the alpha (key) track is recorded.
• Edit Video and Key Tracks — Both the video and alpha (key) tracks are recorded. The clip loaded into the 

VKA channel transport must have an alpha track.

8. In the BVW-75 Protocol Configuration area, select specific configurations for the protocol you are using.

• Select Disable field timecode reporting to force the server to report timecode only once every video frame. 
If this option is not selected, the server reports timecode every field.

• Select the Protocol ID that you want to use (Abekas 6000, Sony BVW-75, or Generic DDR).

9. Click the Ch-X: list on the left side of the window and select the room that you want to assign to the channel.

10. Click Restart Replay.

A confirmation dialog box is displayed.

11. Click Restart Rio Replay to restart the server application and services with the new setting.

12. Click OK when the restart has completed to dismiss the window.

Configuring a Room for the Odetics Protocol
Set up a Room to use the Odetics protocol to control server channels.

To Configure a Room for the Odetics Protocol

1. Launch the Rio Replay Config application.

You may be prompted to allow the program to make changes on the computer, click Yes.

2. Click the Protocols tab.
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3. Click Room X Configuration and select the room you want to configure. Later you will assign this room to a 
channel.

4. In the RS422 Protocol area, select Odetics.

5. In the Response Time area, select how quickly the server executes the Clip Play command after the Clip Load 
command.

• Fast — Executes the play command immediately after the load command. This is recommended when 
controlling the server from an external switcher.

• Accurate — Executes the play command only after receiving confirmation that the clip has loaded. This is 
recommended when controlling the server from an automation system.

6. In the Edit Timing area, select a timing offset for when you are controlling the server from an external editor 
over serial.

• Timecode Alignment — Select the offset, in frames, of the timecode information that is sent to the editor 
during playout or record.

• Source Alignment — Select the offset, in frames, of the timecode information that is sent to the editor 
during playout.

• Out Point Offset — Select the offset, in fields, of the out-point timecode value that is sent to the editor 
during record.

7. In the Video Edit Effect area, select which tracks get recorded when an external editor issues the Video Record 
command to the server.

• Edit Video Track — Only the video track is recorded.
• Edit Key Track — Only the alpha (key) track is recorded.
• Edit Video and Key Tracks — Both the video and alpha (key) tracks are recorded. The clip loaded into the 

VKA channel transport must have an alpha track.

8. In the Odetics Protocol Configuration area, select specific configurations for the protocol you are using.

• Select Disable field timecode reporting to force the server to report timecode only once every video frame. 
If this option is not selected, the server reports timecode every field.
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• Select the Protocol ID that you want to use (Abekas 6000, Sony BVW-75, or Generic DDR).

9. Click the Ch-X: list on the left side of the window and select the room that you want to assign to the channel.

10. Click Restart Replay.

A confirmation dialog box is displayed.

11. Click Restart Replay to restart the server application and services with the new setting.

12. Click OK when the restart has completed to dismiss the window.

Configuring a Room for the VDCP Protocol
Set up a Room to use the VDCP (Louth) protocol to control server channels.

 NOTE:
When controlling the server from a remote device over ethernet, you must select the port on the server 
corresponding to the channel transport you want to send commands to. For example, channel transport A = port 
8000, channel transport B = port 8001, and so on.

To Configure a Room for the VDCP Protocol

1. Launch the Rio Replay Config application.

You may be prompted to allow the program to make changes on the computer, click Yes.

2. Click the Protocols tab.

3. Click Room X Configuration and select the room you want to configure. Later you will assign this room to a 
channel.

4. In the RS422 Protocol area, select VDCP.

5. In the Restrict to Folder area, select if you want to restrict remote control of the selected room to only seeing 
the contents of a specific folder, or all folders (All Folders).
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6. In the Response Time area, select how quickly the server executes the Clip Play command after the Clip Load 
command.

• Fast — Executes the play command immediately after the load command. This is recommended when 
controlling the server from an external switcher.

• Accurate — Executes the play command only after receiving confirmation that the clip has loaded. This is 
recommended when controlling the server from an automation system.

7. In the Channel Control Port area, select whether you want to use the serial ports or ethernet connection for 
the channels assigned to the room.

8. In the Edit Timing area, select a timing offset for when you are controlling the server from an external editor 
over serial.

• Timecode Alignment — Select the offset, in frames, of the timecode information that is sent to the editor 
during playout or record.

• Source Alignment — Select the offset, in frames, of the timecode information that is sent to the editor 
during playout.

• Out Point Offset — Select the offset, in fields, of the out-point timecode value that is sent to the editor 
during record.

9. In the Video Edit Effect area, select which tracks get recorded when an external editor issues the Video Record 
command to the server.

• Edit Video Track — Only the video track is recorded.
• Edit Key Track — Only the alpha (key) track is recorded.
• Edit Video and Key Tracks — Both the video and alpha (key) tracks are recorded. The clip loaded into the 

VKA channel transport must have an alpha track.

10. In the VDCP Configuration area, select specific configurations for the protocol you are using.

• Select Louth Preview to allow clips to be pre-cued in the background for seamless back-to-back transitions 
during playout.

• Select Allow playlist control to allow a playlist to be cued and played from an external device just like a 
clip.

• In the Maximum length of Clip Name field, select the maximum length of a clip name that is reported to 
the controlling device.

11. Click the Ch-X: list on the left side of the window and select the room that you want to assign to the channel.

12. Click Restart Replay.

A confirmation dialog box is displayed.

13. Click Restart Replay to restart the server application and services with the new setting.

14. Click OK when the restart has completed to dismiss the window.

Configuring a Room for the AMP Protocol
Set up a Room to use the AMP protocol to control server channels.

 NOTE:
When controlling the server from a remote device over ethernet, you must select the port as 3811 and then select 
the channel you want to send the commands to.

To Configure a Room for the AMP Protocol

1. Launch the Rio Replay Config application.

You may be prompted to allow the program to make changes on the computer, click Yes.

2. Click the Protocols tab.
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3. Click Room X Configuration and select the room you want to configure. Later you will assign this room to a 
channel.

4. In the RS422 Protocol area, select AMP over Ethernet.

5. In the Response Time area, select how quickly the server executes the Clip Play command after the Clip Load 
command.

• Fast — Executes the play command immediately after the load command. This is recommended when 
controlling the server from an external switcher.

• Accurate — Executes the play command only after receiving confirmation that the clip has loaded. This is 
recommended when controlling the server from an automation system.

6. In the Edit Timing area, select a timing offset for when you are controlling the server from an external editor 
over serial.

• Timecode Alignment — Select the offset, in frames, of the timecode information that is sent to the editor 
during playout or record.

• Source Alignment — Select the offset, in frames, of the timecode information that is sent to the editor 
during playout.

• Out Point Offset — Select the offset, in fields, of the out-point timecode value that is sent to the editor 
during record.

7. In the Video Edit Effect area, select which tracks get recorded when an external editor issues the Video Record 
command to the server.

• Edit Video Track — Only the video track is recorded.
• Edit Key Track — Only the alpha (key) track is recorded.
• Edit Video and Key Tracks — Both the video and alpha (key) tracks are recorded. The clip loaded into the 

VKA channel transport must have an alpha track.

8. In the AMP Protocol Configuration area at the bottom of the window, select specific configurations for the 
protocol you are using.

• Select Disable field timecode reporting to force the server to report timecode only once every video frame. 
If this option is not selected, the server reports timecode every field.
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• Select Allow overlapped commands to allow the server to accept overlapping commands.
• Select Allow playlist control to allow a playlist to be cued and played from an external device just like a 

clip.
• For the Folder Format, select Ross or Sony.
• Select the Protocol ID that you want to use (Abekas 6000, Sony BVW-75, or Generic DDR).

9. In the RossTalk area, select the Port number to use.

10. Click the Ch-X: list on the left side of the window and select the room that you want to assign to the channel.

11. Click Restart Replay.

A confirmation dialog box is displayed.

12. Click Restart Replay to restart the server application and services with the new setting.

13. Click OK when the restart has completed to dismiss the window.

Clip ID Support
Devices using the VDCP or Odetics protocol can use the 8-character clip ID assigned to a clip. By default, the 
server does not assign a clip ID to the clip when it is recorded or imported. If there is no clip ID, the first 8 
characters of the clip name are used instead.
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AsRun Log Report Creator
The server keeps a log of stills and clips that have been played in their entirety on all channels of the server. This 
information can then be filtered and output into either a CSV file or a PDF report.

 NOTE:
Clips must be played out in their entirety to be added to the AsRun log.

This chapter discusses the following topic:

• Running an AsRun Report
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Running an AsRun Report
Generate a PDF or CSV report of what clips and stills were played on the server.

To Run an AsRun Report

1. Launch the AsRunReport application on your server.

2. Set the parameters and filters you want to apply to the report.

• Report Name — The name that appears on the report.
• Additional Notes — Any additional notes that you want to appear on the report.
• Format — Select how you want the report to be formatted.

› Aggregate — Lists how many times each clip was played during the selected date range
› Individual — Lists every instance that a clip was played, including the start and stop times, during the 

selected date range
• Date Range — Set the from and to date range between which you want to generate the report.
• Channels — Select which transport channels on the server that you want to generate the report for. 

Channels that are not present on your server are grayed out.
• Media Players — Select whether you want to show only audio clips, only video clips, or both.
• Media File Name — Enter a name or part of a name in the field, or leave the field blank. The clips that were 

played during the date range will be filter to only include those clip names that include the Media File 
Name. If no name is specified the filter will return all clip names.

3. Click Apply Filter.

The table below lists the results of the filtered search.

You can change the filter settings and click Apply Filter again to update the search results.
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4. Click a Create button to generate the report file. You are prompted for a location to save the file.

• Create CSV — Creates a standard comma segmented value (CSV) file.
• Create PDF — Creates a formatted PDF report file.

5. Click Exit.
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Maintenance and Specifications
Refer to the following information for best practices regarding maintaining your server.

 NOTE:
The information in this section is subject to change without notice.

This chapter discusses the following topics:

• Media Drives
• Resources
• Operating Temperature
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Media Drives
The server uses a RAID array of media drives to store all media content.

Disk Space
The amount of free disk space that is available for clips is shown at the top of the Rio Replay Explorer window. The 
free space is shown in time (HH:MM:SS:FF) and percentage of free space on the drive. When the amount of free 
space goes below 10% the text is highlighted in yellow. If the amount of free disk space goes below 5% the text is 
highlighted in red.

When the amount of free disk space goes below 5% you should consider removing unused content in order to 
free-up media disk space. To assist you in locating older or unused content, the Clip Library contains Date Loaded 
and Date Played columns that can be used to sort content.

Resources

Operating Temperature
The system has been qualified at an operational temperature range of 13 to 35°C (55 to 95°F) and a non-condensing 
humidity range of 20 to 80%.

 NOTE:

› The operator is responsible for providing sufficient ventilation to maintain surface temperature below 40°C 
(104°F) at the center of the top cover of the server chassis.

› Non-condensing conditions should be maintained at all times.
› The maximum storage period inside the shipping package is one year.

Table 16.1  Model Resources

Resource 8-Ch 12-Ch
Video Inputs 8 12

Video Outputs 8 12

AES Audio Inputs 16 16

AES Audio Outputs 16 16

Analog Audio Outputs 2 3

Table 16.2  Safe Operation and Non-operating Environmental Conditions

Environmental Condition Operating Range Non-operating Range
Temperature Server Chassis: 13 to 35°C (55 to 95°F)

Control Panel: 0 to 40°C (32 to 104°F)
-40 to 65°C (-40 to 149°F)

Relative Humidity Server Chassis: 20 to 80% non-condensing
Control Panel: 20 to 50% non-condensing

5 to 95% non-condensing

Max. Wet Bulb Temperature 29.5°C (85°F) non-condensing 35°C (95°F) non-condensing

Max. Temperature Gradient 15°C/hour (59°F/hour) 15°C/hour (59°F/hour)

Altitude Range -300 to 2,000m (-984 to 6,561ft.) -300 to 12,200m (-984 to 
40,026ft.)
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